
Thank you for purchasing the CASIO MPC-701 series.
This guide describes the basic operations of the
MPC-701 series.
Read this guide in its entirely before handling or
operating the product, and keep it close at hand so it
can be easily referenced.

FIVA
User’s Guide

(Product No: MPC-701 series)
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• Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation in

the United States and/or other countries.

• smARTwriter, smARTscribble and Quick Trainer are trademarks or registered trade-

marks of Advanced Recognition Technologies in the United States.

• Other company, product and service names used herein may also be trademarks or

service marks of respective companies.

International ENERGY STAR® Program
As a member of the International ENERGY STAR®

Program, CASIO products have been judged to
meet International ENERGY STAR®  standards.
ENERGY STAR®  is a U.S. registered mark.

Power Plug and AC Adapter

Note
AC cord plug and wall outlet illustrated in this User’s Guide shows the
two-pin plug type. It may not be the same shape of AC cord plug used
in your area.
FIVA’s AC adapter has an automatic voltage switching circuit (input:
100 to 240VAC, 50/60Hz) and lets you use your FIVA under AC power
virtually anywhere in the world without having an extra power-transformer.
Note, however, that AC cord plug shape differs according to area you
are in. Make sure that the AC cord you will use can fit into wall outlet
and is compliance with the local electric safety standard.
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• Do not dispose of the box and packing materials. Use the box and packing materials
for storage and transport.

Keep in a safe place

Packing List

Thank you for purchasing the CASSIOPEIA FIVA MPC-701 series. A list of the items
included with this product is given below. Confirm that nothing is missing or damaged.
If anything is missing or damaged, contact the dealer from which you purchased this
product.

FIVA MPC-701

Stylus Screen protector

Neck strap

Battery pack

Modular Cable

 UNIT ID sticker

Windows2000
Quick Start Guide Product

Recovery CD-ROM

User’s Guide

FIVA701
User s Guide

Windows
2000 QuickStartGuide

FiVACD

×2

×2
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Safety Precautions

• To use this product safely and correctly, read this User’s Guide
thoroughly and operate as instructed.
After reading this guide, keep it close at hand for easy reference.
Please keep all informations for future reference.

• Always observe the warnings and cautions indicated on the product.
• If this guide is misplaced or damaged so as to be unreadable, a

new one can be ordered. To obtain a new User’s Guide, contact the
dealer from which this product was purchased.

About the icons

In this guide various icons are used to highlight safe operation of
this product and to prevent injury to the operator and other
personnel and also to prevent damage to property and this
product. The icons and definitions are given below.

Indicates that there is a risk of severe injury or death if used incorrectly.

Indicates that injury or damage may result if used incorrectly.

Icon examples
To bring attention to risks and possible damage, the following types
of icons are used.

The  symbol indicates that it includes
some symbol for attracting attention
(including warning). In this triangle the
actual type of precautions to be taken
(electric shock, in this case) is indicated.

The  symbol indicates a prohibited
action. In this symbol the actual type of
prohibited actions (disassembly, in this
case) will be indicated.

The  symbol indicates that a
restriction. In this symbol the type of
actual restriction (removal of the power
plug from an outlet, in this case) is
indicated.

 Warning!

 Caution!
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 Warning!

Handling FIVA

Should FIVA malfunction, start to emit smoke or a
strange odor, or otherwise behave abnormally,
immediately shut down the power, remove batteries,
and unplug the AC adapter from the power outlet.
Continued use creates the danger of fire and electric
shock.
• Contact your original retailer or authorized distributor.

Do not place containers of liquids near FIVA and do
not allow any foreign matter to get into it. Should
water or other foreign matter get into FIVA,
immediately shut down the power and unplug the AC
adapter from the power outlet. Continued use creates
the danger of shorting, fire and electric shock.
• Contact your original retailer or authorized distributor.

Never bring in FIVA a bathroom or any other location
where the possibility of splashing or high humidity
exists. Use of FIVA in such an area creates the danger
of electric shock. Be especially carefully when using
FIVA while rain or snow is falling, or in beach areas.

Never try to take FIVA apart or modify it in any way.
High-voltage components inside FIVA create the
danger of fire and electric shock.
• Contact your authorized distributor for all repair and

maintenance.

Should you drop FIVA and damage it, immediately
shut down the power and unplug the AC adapter from
the power outlet. Continued use creates the danger of
shorting, fire and electric shock.
• Attempting to repair FIVA yourself is extremely

dangerous. Contact your authorized distributor for all
repair and maintenance.

 MPC701M50E#p1~20 02.11.22, 10:09 AM3



4

 Warning!

The liquid inside the LCD is harmful to humans. Never
touch it or allow it to get in your mouth.
• Should liquid from the LCD panel accidentally get into

your mouth immediately wash out your mouth with
clean water. If it gets onto your skin, immediately rinse
for at least 15 minutes with clean tap water. In either
case, consult a physician.

Should lightning strike nearby, stop using FIVA, and
disconnect modular cable or the power cord from the
power outlet.
Continued use creates the danger of electric shock or
damage.

Power Plug and AC Adapter

Note
AC cord plug and wall outlet illustrated in this User’s Guide shows the
two-pin plug type. It may not be the same shape of AC cord plug
used in your area.

Use only a proper AC electric outlet (100V~240V)
when powering FIVA with the AC adapter. Use of an
outlet with a different voltage from the rating creates
the danger of malfunction, fire, and electric shock.
Overloading an electric outlet creates the danger of
overheating and fire.

Do not place bedding materials on top of the AC adapter
while it is on or place the FIVA on heated flooring or
near other heating apparatus during charging.
Doing so might cause it to deform, or result in a fire or
malfunction.

Make sure the power plug and AC adapter plug are
inserted as far as they will go. Loose plugs create the
danger of electric shock, overheating, and fire.
• Do not use the adapter if the plug is damaged. Never

connect to a power outlet that is loose.

AC100~240V
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 Warning!

Use a dry cloth to periodically wipe off any dust built
up on the prongs of the plug. Humidity can cause
poor insulation and create the danger of electric
shock and fire if dust stays on the prongs.

Do not allow the power cord or plug to become
damaged, and never try to modify them in any way.
Continued use of a damaged power cord can cause
deterioration of the insulation, exposure of internal
wiring, and shorting, which creates the danger of
electric shock and fire.
• Contact your authorized distributor whenever the power

cord or plug requires repair or maintenance.

Use only the AC adapter specified by CASIO for this
product. Use of another type of AC adapter creates
the danger of fire.

Specified 
AC adapter
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 Warning!

Battery Pack

Use only the battery pack that comes with FIVA. When
the battery pack reaches the end of its life, replace it
with a new battery pack as specified by CASIO. Other
types of batteries have different voltage rating and
polarity, which creates the danger of fire and bursting
of the batteries.

Never try to take the battery pack apart or modify it
in any way. Doing so creates the danger of
overheating, fire, and bursting of the battery pack.

Never throw the battery pack into fire or otherwise
expose it to direct flame. Doing so creates the danger
of fire and explosion.

Never allow the positive (+) and negative (–) poles of
the battery to become connected by metal. Do not
store or transport the battery pack together with metal
necklaces, hairpins, or other metal items. Connection
of the battery pack poles creates the danger of
overheating, fire, and explosion.
• When transporting or storing the battery pack, wrap it

in plastic to keep the poles away from metal items that
might cause a short.

Battery 
(included)
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 Caution!

Handling FIVA

Do not place FIVA on an unstable or uneven surface.
Doing so can cause FIVA to fall, creating the danger
of malfunction, fire, and electric shock.

Do not leave FIVA in the following areas.
• Areas where FIVA will be subject to large amounts of

humidity or dust, or directly exposed to hot or cold air.
• Areas exposed to direct sunlight, in a close motor vehicle,

or any other area subject to very high temperatures.

The above conditions can cause malfunction or
deformation of FIVA, which creates the danger of fire.

When transporting FIVA, take care to avoid subjecting
it to vibration and impact. This unit contains a hard
disk and other precision components that can be
damaged by rough handling.

The AC adapter normally becomes warm during
use. Avoid allowing the AC adapter to rest on your
lap or other part of your body when using it for
long period. Long term with the AC adapter creates
the danger of burns.

heated
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 Caution!

Power Cord and Peripherals

Do not overly bend the power cord, do not allow it to
be caught between desks or other furniture, and
never place heavy objects on the power cord. Doing
so can cause shorting or breaking of the power cord,
creating the danger of fire and electric shock.

Be sure to grasp the plug when unplugging the power
cord from the wall outlet. Pulling on the cord can
damage it, break the wiring, or cause short, creating
the danger of fire and electric shock.

Never touch the plug while your hands are wet. Doing
so creates the danger of electric shock. Pulling on the
cord can damage it, break the wiring, or cause short,
creating the danger of fire and electric shock.

When using headhone, make sure you do not turn up
the volume too high. Doing so can cause heaning
damage.

Avoid use in areas where the brightness around the
display is very different from surrounding lighting, or
where the sunlight is shining directly on the display.
Such conditions can cause eye fatigue.
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Before Using FIVA

• This product has been designed and manufactured under stringent
quality control. Should you suspect FIVA is defective or
malfunctioning, contact your original dealer or authorized
distributor. Repair and maintenance are subject to the terms and
conditions of the Warranty.
The mis-operation of electronic product may create a risk of injury
caused by a fire or electric shock, etc.  To avoid the accident, be
sure to follow the instructions below.

Follow the cautions
The cautions for FIVA are described on pages from 2 to 8.

Do not use FIVA if it does not work correctly
Contact your original retailer or authorized distributor.

If FIVA works abnormally
If FIVA malfunctions, or emits smoke, strange odor or noise, etc.,
immediately shut down the power, remove the battery pack, and
unplug the power cord of the AC adapter from the power outlet.
Contact your original retailer or authorized distributor.

• CASIO COMPUTER CO., LTD. shall not be held liable for any loss
or claims due to using this product except as instructed to do so in
this User’s Guide.

• CASIO COMPUTER CO., LTD. shall not be held liable for any loss
or claims (lost profits, interruption of business, corruption or loss of
memory data, etc.) by you or any third party due to the use of this
product or the inability to use this product for a specific purpose,
except as specifically stipulated by law.

• Unauthorized copying of this product or its software is prohibited.
• This product is guaranteed only when operating under the version

of Windows 2000 operating system that comes bundled with it.

Product Application
• This product is intended for use as a general office computing

device.
• CASIO makes no warranties that this product is fault-tolerant. It is

not designed, manufactured or intended for use in any equipment
or system (such as traffic control devices, safety devices, medical
devices, etc.) where the malfunction or misoperation of FIVA could
lead directly to death, personal injury, or serious damage to
physical assets.
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System Recovery
• This product comes with Windows 2000 operating system and a

collection of utility software pre-installed on its hard disk. Should the
system start to malfunction or produce errors, you can use the
“Product Recovery CD-ROM” that comes with FIVA to restore the
factory default system. This returns FIVA the same settings and
state it was in when you originally purchased it.

Computer Viruses

Avoiding Computer Viruses
A computer virus is a program. It gets installed on your system
without you being aware of it, and can do anything from displaying
strange messages to destroying your data and other programs. A
virus can enter your system via a floppy diskette or network. Taking
the following precautions are normally sufficient to protect against
having a virus invade your system.

• Write protect the master copies of your programs and data files.
• Never open data files or run programs of unknown origin.
• Use a commercially available virus checker to check new

programs, and periodically check your system for virus
contamination.

Use the latest version of a commercially available virus
checker to check your system.
An immediate virus check is recommended in the following cases.

• Check your system each time you start up your computer.
• Check any data file or program you received on a floppy diskette or

other external media, over a network, from a BBS or the Internet,
via e-mail, etc. before opening the file or running the program.

 MPC701M50E#p1~20 02.11.22, 10:09 AM10
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FIVA

Precaution Label
• The label shown above is affixed to the bottom of FIVA. Be sure to

carefully observe these precautions at all times. Never remove this
label. Should this label ever start to come off or should its contents
become unreadable, contact your original dealer or authorized
distributor.

Power Requirements
• Plug the AC adapter into a power outlet rated for 100V to 240V AC,

50/60Hz only.
• Do not connect FIVA to the same outlet of another device that

generates electrical noise. Such a device can corrupt data in FIVA.

Turning Off Power
• Never unplug the power cord or otherwise cut off power to FIVA

while the system is starting up or while a program is running. Doing
so can cause data to be lost or corrupted, and can lead to
malfunction of FIVA.

• Do not turn power off and then suddenly back on again. Doing so
can cause data to be lost or corrupted, and can lead to malfunction
of FIVA.

Cables
• Never pull on cable or place a heavy object on it. Doing so can

cause the cable to break or short.

The bottm of FIVA on the AC adapter becomes warm during use
• This is caused by the CPU operation or the current when FIVA’s

battery is charged. This is not malfunction. The heating value
charges according to the condition of use.

• When FIVA or the AC adapter is warmer than usual, shut down the
power, unplug the power cord of the AC adapter and remove the
battery packs. Contact your original retailer or authorized distributor.

Caution
• Turn off this product before connecting or

disconnecting peripherals.
• Never apply impact or vibration.
• Never take this product apart.
• Use only the specified AC adapter.
• The bottom of this product becomes warm

during use. Avoid using it in your lap for a

long period.
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Important

Avoid Strong Vibration and Impact
• Strong vibration or impact can cause malfunction. Be particularly

careful when FIVA is turned on. Vibration and impact can cause
corruption of data on built-in hard disk.

• Do not press down hard on the periphery of the screen. If any entry field
near the periphery, right or left side of the screen as shown, suppose to
be located, the area may be activated accidentally by the pressure.

Do not press down hard 
on these sections.

FIVA conforms to drip-proof specifications.
 • This means that it can be used in locations where it is subjected to

slight amounts of rain or spraying with water. However, if FIVA gets
wet, sufficiently wipe off rain or water droplets with a dry cloth.

Hard Disk Data

• The hard disk drive can be damaged by shock. The exchange of
the hard disk sometimes becomes necessary when strong
vibration or impact are given to it though a hard disk is protected
due to the shock absorption material.

Disk Operations
• A lit hard disk drive access lamp ( ) indicates that a disk operation

is being performed.
• Never shut down while a hard disk drive is being performed. Doing

so can make data or applications on the disk unusable.

Backup Data
• You should occasionally back up data on the hard disk by copying

it to floppy diskette. This ensures that you always have backup data
on hand in case of accidental data deletion or corruption caused
by mis-operation, malfunction, maintenance, etc.

Note that CASIO is not liable for any losses suffered by you or any
third party due to the loss of data stored on FIVA’s hard disk.
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Options

Non-CASIO options
• Check with each manufacturer for compatibility before using any

non-CASIO options with this unit.
• CASIO assumes no responsibility for any loss (including but not

limited to personal injury, material loss, damage to FIVA) suffered
by you or other arising out of the use of a non-CASIO option.

Use Only as Directed
• Be sure to connect or disconnect an option only as expressly

directed in the documentation that comes with the option.
• Incorrect use of options can cause malfunction and serious damage

to FIVA, which can required extensive repair work to correct.

Consumables
The following items are consumables.
You will need to inform your original dealer or authorized distributor of
the model number of your unit when purchasing the stylus, screen
protective film, and battery pack.

Stylus
• Purchase a new stylus whenever the tip of your stylus becomes damaged.

Screen Protective film
• Purchase a new screen protective film when the one on your FIVA

becomes scratched to the point that it makes display contents
difficult to see.

Battery Pack
• Long use of the battery pack causes it to deteriorate and lose its

ability to recharge. If you feel your battery pack is not providing
enough operating time, it may be time to contact your dealer or
authorized distributor about purchasing a new one. (page 91)

 • Use his product foronly specified CASIO product.

 • Necver take this product apart or modify it or apply an impact on it.

 • Never allow the positive and negative poles to become shorted by metal.

 • Dispose of used batteries according to the manufacture's instructions.

                                        R BATTERY PACK MPC-773BAT

Li-Ion Dc 11.1V 2000mAh

CASIO COMPUTER CO.,LTD.

MADE INTAIWAN R.O.C

Danger

Li-ion

Danger

• Use this product for only specified CASIO product.
• Never take this product apart or modify it or apply an 

impact on it.
• Never allow the positive and negative poles to become 

shorted by metal.
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Cautions When Carrying FIVA Around
• Do not carry FIVA around in a bag containing hard objects with

protrusions. If these objects bump against FIVA or force is applied
from above, the display may be scratched or FIVA may malfunction.

• Before moving FIVA, be sure to shut down the power, and make
sure that all peripheral devices (FDD unit, etc.) are disconnected.
Then, move FIVA separately from these devices. Carrying devices
around holding them by their connector cables may cause cables
to break or devices to malfunction.

• When carrying FIVA around or when FIVA is not used, shut down
the power, and put it in a protective case, for example, to prevent
the display from being scratched.

Cautions When Storing FIVA
When FIVA is not to be used for a long time and is to be stored, carry
out the following to prevent power from completely running down:
• Fully charge the battery packs with they connected to FIVA, remove

the battery packs, and insulate the battery pack terminals with
Cellotape or other insulating material before putting FIVA into storage.

• Store FIVA and the battery packs in the box and packing materials
that they originally came with.

Disposal
When it comes time to dispose of your FIVA, do so in accordance
with local regulations in your area. Contact your local government
authorities for details about proper disposal methods.
• Battery disposal

The product that you have purchased contains a rechargeable
battery. The battery is recyclable.
Affix tape to the battery contacts before disposing of the battery.At
the end of its useful life, under various state and local laws, it may
be illegal to dispose of this battery into the municipal waste stream.
Check with your local solid waste officials for details in your area for
recycling options or proper disposal.

Note
• Prior to your disposal or give away of the MPC-701 to a third

party, you are recommended to take necessary action to erase
completely all important data saved on the HDD on your own
account not to crate a trouble caused by the leak of data.
In order to erase such the data, you use either a specific
application software or physically destroy the HDD with a tool or
magnetically with strong magnetism so that none of the data on
the HDD can be utilized by unauthorized persons.
To give away your MPC-701 without erasing or destroying the
operating system and application software installed may also
violate the User’s License Agreement of respective software.
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Maintenance and Care

Normal Care

Shut down the power and unplug the power cord from the
power outlet before cleaning FIVA. Cleaning FIVA with the
power on creates the danger of electric shock.

• Clean FIVA by wiping it with a soft, dry cloth. If FIVA is very dirty,
wipe it with a cloth that has been moistened with a weak solution of
water and a mild neutral detergent. Wring out all excess of moisture
before wiping.

• Thinner, benzene, or other organic agents can cause deformation
or discoloration of FIVA’s case, and even malfunction of FIVA. Never
use such agents when cleaning FIVA.

• Use only the stylus accompanied with the FIVA (or specified by
CASIO) for inputting on the LCD screen. Before using the stylus,
remove any dirt from the tip of it and on the screen. Dirt if any may
make an input with the stylus more difficult or damage on the
screen. Also take care that you do not misplace or lose the stylus.

• Clean the FIVA’s LCD screen by wiping it with a soft, clean cloth.
Never use water, neutral detergents, or chemically treated cloths to
clean the screen. A dirty screen can interfere with response to
stylus operations, and smooth movement of the stylus tip. The
screen is easily scratched, so take care that you do not apply to
much pressure when cleaning it.
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Maintenance

Never remove FIVA’S outer cover or otherwise try to take it
apart or modify it in any way. High voltage inside the case
creates the danger of electric shock.

In the following instances, immediately shut down the power, remove
the battery packs, unplug the power plug from the power outlet, and
contact your original dealer or authorized distributor:

• Damaged power cord or plug
• Liquid leaking from FIVA
• Exposure of FIVA to water or rain
• Unit being dropped
• Damaged unit cover
• Very abnormal function
• Abnormal operation

Never try to make any adjustments except as specifically instructed
by this User’s Guide. Improper adjustment or modification of FIVA can
permanently damage it and make it impossible to restore normal
operation.

Never attempt to repair or modify this unit in any way.
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About This User’s Guide

This User’s Guide is divided into the four sections shown below. Be
sure you read the section titled “Before Using FIVA” starting from
page 9 before you do anything else.

Before Using FIVA
This section provides important safety precautions and things you
need to know to use FIVA correctly.

Chapter 1 Getting Ready
This chapter provides you with general description of functions and
part names. It also explains required procedures for turning power on
and off for the first time.

Chapter 2 Using FIVA
This chapter explains how to turn on power and perform a number of
basic computer operations.

Chapter 3 Supplementary Information
This chapter contains information about how to connect peripherals
and what to do when you experience problems.

Important This mark indicates important cautions and things to which you need
to pay attention when you operate the FIVA.

Note This mark indicates that you need to memorize.

The words “Windows 2000” and “Windows” used in this user’s guide simply
refer to the “Microsoft® Windows® 2000 Professional” operating system.
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Chapter 1
Getting Ready
This chapter provides you
with general description
of functions and part
names. It also explains
required procedures for
turning power on and off
for the first time.
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Features

The MPC-701 Series is a lightweight and compact pen type
computer.

8.4-inch SVGA (800 × 600) TFT LCD
• High-density TFT color LCD has high resolution.

MPC-701M30E: VE-transflective type
MPC-701M50E: Transmissive type
Backlight turns on automatically in response to the brightness
sensor. (M30E only)

Highly mobile B5 size
• Compact 1,400g, B5 size goes along anywhere.
• Comes with 128MB of memory as standard (384MB maximum) and

a 20GB hard disk built in.
• The hot-swapping function allows two power supplies (battery pack

or AC adapter) to be used. FIVA also comes with various power
management functions.

• 10-key pad with backlight for mobile use is provided with a key
switch.

• Built-in Windows 2000 operating system lets you take your desktop
files along everywhere.

Versatile Stylus Interface
• Pointing is performed by touching the screen with a stylus.
• Highly efficient handwriting recognition.
Versatile Networking
• Can be connected to existing LAN or other networks using

standard LAN or built-in modem.
• Comes with PC card and CF card slots, and USB Ver.2.0 as

standard, enabling connection of various peripheral devices.
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Part Names and Their Functions

The part names introduced in this chapter are used throughout the rest of this User’s
Guide.

qLCD screen
wIndicator lamps

eBrightness sensor
rSpeaker

yMicrophone port
uHeadphone port

iUSB port

oBacklight switch

!1Hook

!2Stylus

!3Keyboard

!4Battery pack 
   compartment

tPower switch

!0Key lock switch
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qLCD screen
SVGA (800 × 600) 8.4" type color TFT with touch panel
MPC-701M30E: VE-transflective type
MPC-701M50E: Transmissive type

wIndicator lamps
LED lamps indicate the following states from the left as you face FIVA:
Power (PW-LED) Indicates the power state. (page 92)
HDD (HDD-LED) Indicates the disk accessing state.

(Lights green during accessing.)
BATT1 (BAT-LED) Indicates the power state of battery pack 1. (page 35)
BATT2 (BAT-LED) Indicates the power state of battery pack 2. (page 35)

eBrightness sensor
Used for detecting the surrounding brightness, this sensor is interlocked with
backlights control.

rSpeaker
Built-in monaural speaker.

tPower switch ( )
Turns the power on/off, and is used for suspending FIVA.

yMicrophone port ( )
Used for connecting a commercially available voice input microphone.

uHeadphone port ( )
Used for connecting commercially available audio use headphones or
speakers.

iUSB port (       )
Used for connecting USB peripheral devices. (USB Ver.1.1 compliant)

oBacklight switch (AUTO/ON/OFF) (page 29)
MPC-701M30E: 3 settings for the LCD screen and keyboard backlight.
MPC-701M50E: 3 settings for keyboard backlights.

!0Key lock switch (LOCK/FREE)
Switch (LOCK/FREE) for preventing wrongful input on the keyboard. (page 29)

!1Hook
Used for attaching the neck strap. (page 30)

!2Stylus
Use this stylus for entering items on the touch panel screen.

!3Keyboard
Contains the control keys and 10-key pad. Keys are provided with an EL
backlight that is interlocked with the backlight switch.

!4Battery pack compartment
Contains two battery packs.
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Back

qBattery pack compartment

wHook

ePC card slot

rUSB port
tModem port

yLAN port

uPower adapter port
iCF card slot

oInfrared
   communications port

!0RGB port

!1Ventilation hole

!5Battery release latch

!4Battery pack

!3Reset switch

!2Memory replacement cover
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qBattery pack compartment
Contains the battery pack.

wHook
Used for attaching the neck strap.

ePC card slot (PCMCIA CARD)
Used for inserting the PC card.

rUSB port (       )
Connects USB peripheral devices. (USB Ver.2.0 compliant)

tModem port ( )
Connects the built-in modem to the telephone line by modular cable.

yLAN port (LAN)
Connects to an Ethernet network.

uPower adapter port ( )
Connect the power cord from the AC adapter to this port.

iCF card slot (CF CARD)
Used for inserting the CF card.

oInfrared communications port
Used for data communications by the IrDA interface.
Enables data communications with another computer equipped with the infrared
(IrDA) interface, and connections with an IrDA network that is compliant with the
IrDA standard.

!0RGB port (RGB)
Used for connecting an external monitor.

!1Ventilation hole
Hole for cooling the inside of FIVA.

!2Memory replacement cover
Used for replacing extended memory.

!3Reset switch
This switch is used for resetting FIVA to its initial settings when the power is
turned ON. If something has caused FIVA to stop functioning, press this switch
with a fine-tipped object. This forcibly turns the power off. Press this switch only
when operation locks up and nothing else works. Otherwise, never press this
switch.

!4Battery pack
Install the removable two battery packs.

!5Battery release latch
Move this release catch to remove the battery pack.
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Key Name

Escape

Delete

Backspace

Tab

Fn

Alternate

Control

10 keys

Enter (Return)

Decimal point

Hyphen

Space

Cursor

Key
ESC

DEL

BS

Tab

Fn

Alt

CTRL

~0 9

Enter

.  

–

Spc

Keyboard

This section describes the basic functions of the keyboard. Actual
keyboard functions may differ in accordance with the application you
are using.

• Keyboard keys are grouped according to function: control keys, 10-key pad, and
arrow keys.

Function

Control
Keys

10-key Pad

Arrow Keys

Description

Cancels an operation.

Deletes the character to the right of the
cursor.

Deletes the character to the left of the cursor.

Inputs a tab operation.

Activates certain “hot keys” functions.

Used in combination with other keys to
perform operations and execute commands.

Used in combination with other keys to
perform operations and execute commands.

Inputs numbers (0 to 9).

Enters data or inserts a carriage return.

Inputs a decimal point.

Inputs a hyphen or a minus sign.

Inputs a blank space.

Moves the cursor on the screen.
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Key Combinations
• Key combinations where you must hold down one key and press a

second are indicated by a plus symbol.
• The following shows the key combinations that are available with

the Fn  key. This is called the “hot keys” function.

In Windows 2000 operating system, you can use English input by executing CTRL+ "8",
"9" and ALT+ "8", "9" during the setup operation.

Key

Fn + “1”

Fn + “2”
Fn + “3”

Fn + “4”

Fn + “5”

+ “6”Fn

+ “7”Fn

Fn + “0”

Ctrl Alt Del

Fn + “ . ”

Fn + “–”

Fn Spc+
Fn +

Description

Decreases LCD brightness. (page 57)

Increases LCD brightness. (page 57)

Puts FIVA into Standby Mode. (page 135)

Puts FIVA into Hibernation Mode. (page 135)

Decreases speaker sound volume. (page 131)

Increases speaker sound volume. (page 131)

Stops speaker sound.

Changes the destination at which the screen is displayed
when an external monitor is connected. (page 107)

Starts up Windows Security.

Launches the screen calibration routine. (page 58)

Launch previously defined applications. (page 125)

Perform page operations (PgUp, PgDn, Home, End).

Backlight switch
This 3-stage switch controls lighting of the backlight for the keyboard.
AUTO: The backlight is turned on/off automatically according to the

surrounding brightness.
ON: The backlight is on at all times depending on power

management settings.
OFF: The backlight is off at all times.
(MPC-701M30E: The backlight switch is also interlocked with the LCD
screen backlight.)

Key lock switch
This switch is for preventing wrongful entry on the keyboard.
LOCK: Disables entry on the keyboard. (The keyboard backlight is

turned off.)
FREE: Enables entry on the keyboard.

Backlight Switch and Key Lock Switch
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Before Using FIVA for the First Time

Affixing the Screen Protector on to the LCD screen
Follow the steps to affix the film.
1. Peel off a thin sheet on each side of the film first.
2. Note the four corners on the Screen Protective Film. The surface

with the corners pointing upward must face to your side and the
other side must face to the LCD screen. Affix it as shown in the
illustration.

Connecting the Neck Strap
When you use the neck strap, be sure to hook it as follows.
If the neck strap is hooked in the wrong way, it cannot move freely
causing excessive pressure over the Hook on the FIVA.

                      

                    

A corner is 
upward

Wrong

Right
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Pulling out the Stylus
Use your finger to slide the stylus from its
storage slot on the front of the FIVA unit.
To replace the stylus, slide it carefully
back into the slot so the raised part of
the stylus enters the slit.

Important • Take care to avoid misplacing the stylus.
• Take care to avoid damaging or breaking the tip of the stylus.
• Keep the tip of the stylus and the FIVA screen clean and free of

dirt. Performing stylus operations when the stylus or screen is
dirty can damage the screen.

Connecting the AC Adapter
Connect the AC adapter to FIVA as shown in the illustration below.
To prevent unnecessary consumption of electrical power, do not
leave the AC adapter plugged into the power outlet when it is not
connected to FIVA.

1. Connect one end of the power cord into the AC adapter. (q).
Connect the other end into the power outlet (w).

2. Firmly connect the AC adapter plug as far as possible into the AC
adapter port ( ) on the side of the FIVA unit (e).

Use only the dedicated AC adapter, model no. AD-
S60160A-E. Use of another type of AC adapter 
creates the danger of fire caused by smoking or 
ignition.

e

q

w
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Power Supply

This section describes how to set up, remove, and charge the battery
packs.
Though operation is possible using the AC adapter only, it is a good
idea to attach the battery packs and charge them before using FIVA
for the first time.

Attaching and Removing the Battery Packs
When you set the full-charged battery packs, you can use this unit
without connecting the AC adapter. Make sure you correctly set the
battery packs so they do not come off accidentally during unit opetation.

Use only the battery pack that comes with FIVA or a
battery pack specified in this User’s Guide. Use of
other type of battery pack creates the danger of fire.

——— When a-two battery pack
is exchanged simultaneously ———

Please connect AC adapter, when you exchange two battery packs
simultaneously. Or please prepare a full charged battery pack, then
change battery. And exchange other battery after waiting until the first
battery pack is recognized by Windows of MPC-701.

To set the battery pack
1. Turn over the FIVA.
2. Push in the battery pack towards the left side (w) while sliding the

battery release latch (q) after sliding the battery release latch on
the attachment side, and then gently insert the right side of the
battery pack. (e)

Make sure the battery pack is set securely to FIVA. Make sure
you attach the battery pack securely to FIVA. An incorrectly
attached battery pack can fall off, creating the danger of
accident and personal injury.

q w

e

Battery release latch
Battery holder
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• Two battery packs can be attached at the same time, and they can
be attached in any order. Of course operation with only one battery
pack is also possible.

To remove the battery pack
Before removing the battery pack, be sure to turn off the power when
the AC adapter is connected to FIVA and a power outlet you can
remove the battery pack without turning off the power. Also, when two
battery packs are attached, one can be removed without turning off
the power.

Important • If you remove the battery pack while the power of the FIVA is
turned on without connecting the AC adapter, data may be
erased. Also, if you remove the battery pack while FIVA is in
Stand-by Mode, data may be erased. To prevent data from
erasing, be sure to connect the AC adapter.
The charged battery pack can be replaced by the "hot swap"
function even if the power is turned on when the battery pack is
attached on one side.

1. Turn over the FIVA.
2. Hold the battery pack hook while sliding the battery release latch

(q) and after sliding the battery release latch on the side to be
removed, pull out the battery (w).

Make sure you have a firm grasp of the battery pack when you
pull it from FIVA. Dropping the battery pack can cause it to fall
on your foot or otherwise cause personal injury.

qSlide the battery release latch.

wLift up while sliding to the 
left side holding the hook.
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Charging the Battery Pack
The AC adapter is used not only to supply power from the AC power
outlet but also to charge the battery pack. The battery pack is also
charged while FIVA is in use (power is on) if the AC adapter
(provided) is connected with the battery pack inserted in the FIVA
unit. Unwanted power consumption can be prevented and safety
ensured if the power outlet side of the AC adapter also is
disconnected when the AC adapter is not connected to the FIVA unit.

Note
• When you buy the battery pack, it is not fully charged. Fully

charge the battery pack before you use it for the first time.
• Before you use a new battery pack for the first time, fully charge

it, disconnect the AC adapter from the FIVA unit, and then
completely use up battery pack power. Though the battery pack
can be used without doing this, the indicated remaining power of
the battery pack may be inaccurate.

1. Attach the battery pack following the procedure above.
2. Attach the AC adapter to the FIVA unit following the procedure

above (q→w→e).

FIVA’s  lamp (BAT1 or BAT2) lights amber when charging starts,
and turns green when charging is complete. If the  lamp lights red
during charging, it can mean that FIVA’s protection circuit has
cancelled the charge operation. If this happens, remove the battery
pack from FIVA and then reattach it to resume charging. The  lamp
lights red frequently during charging indicates malfunction, and you
should contact your original dealer or authorized distributor.

e

q

w

Use only the dedicated AC adapter, model no. AD-
S60160A-E. Use of other type of AC adapter creates 
the danger of fire caused by smoking or ignition.

Use only the dedicated AC adapter, model no. AD-
S60160A-E. Use of other type of AC adapter creates 
the danger of fire caused by smoking or ignition.
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When the two battery packs are used for MPC-701, one of them can be
exchanged by the "hot swap" function at any time,even in the state of the
use MPC-701.
MPC-701 starts battery charge from a large remained capacity battery pack.
Please check the lamp color of BATT1 / BATT2.
When the battery pack under charge becomes full charge, charge of
the other battery pack is started.
Even if the battery pack of the waiting for charge is exchanged to
more remained capacity battery than the charging now,the target of
charge battery pack does not exchange.

Important • If the battery pack is attached to FIVA, do not unplug the AC
adapter until the  indicator lamp turns green (full charge). This
helps to extend battery pack life.

• The battery pack requires period replacement. The end of a
battery pack’s service life is indicated when the battery pack
powers FIVA for a relatively short period after a full charge. When
this happens, replace the battery pack with a new one.

• While the battery pack is being used or recharging, it may
become warm to the touch, this is not a malfunction but it just the
normal operation of the battery pack.

• Locate the AC adapter power cord in a place where it will not be
tripped over.

• When disconnecting the power cord from the power adapter port
on the FIVA unit, hold the connector and draw out straight.

• If the power cord is connected to a power outlet for a long time,
the plug way become dusty. Clean the plug occasionally.

Note
• See page 91 for information about battery pack life and charging

capacity.

Battery Indicator Lamp

Green

Amber

Red, even when chargin

Off during charge

Meaning

Full charge

Charging

Charging is disabled. Try charging again in an area
where temperature is within allowable range.
Charge the battery in the ambient operating environment
(0 to 40°C). The battery sometimes cannot be charged
in low or high temperatures even if charging is
performed within the ambient operating environment.
There is also a possibility of malfunction.

Charge was aborted. Remove battery pack from unit
and check it for external abnormality.
* When two battery packs are attached, only the lamp of

the battery pack being charged lights amber. The
lamp of the other battery pack does not light.
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Turning on Power

Either connect the FIVA unit to the power outlet by the AC adapter, or
attach a charged battery pack.

Turning on the power
Press the power switch until the PW indicator lamp lights.

Important Do not turn on and off in a short time. After turning power off, wait
for at least 10 seconds before turning it back on again.

The first time you turn on the power, you must perform a Windows
2000 operating system setup procedure.
Consult your original detailer for information about the setup
procedure.
You need  to perform this procedure only once. After that, Windows
2000 operating system will boot up automatically when you turn on the
power.

Note
• The screen goes through a number of changes and may even flicker

while Windows 2000 operating system is starting up. This is
normal and does not indicate malfunction of FIVA.

• FIVA’s is equipped with “power management” functions that
automatically go into a low-power standby or hibernation mode if
you do not perform any screen touch or keyboard operation for
about 10* minutes. Input data on the screen when the low-power
Standby or Hibernation is entered is automatically saved, so the
screen reappears on the display when you recover from a low
power mode.
* You can change the trigger time setting using the Power

Management settings under Mobile Cockpit. See page 126.

If power does not turn on when you press the power switch, see the
troubleshooting guide on page 147.
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Windows 2000 Operating System Setup

Introduction
When FIVA is first turned on, Windows 2000 operating system setup
is required for setting license information and other information.
Perform this operation when you turn a newly purchased FIVA on for
the first after. When you next turn FIVA on, the Windows 2000 initial
screen will be displayed according to the details you set up here.

Windows 2000 operating system setup involves the following settings.
You will need to do these settings in advance.
To prevent power from being disconnected during the setup, connect
the AC adapter for extra safety.

Setup Items Description
Licensing Agreement Agreement with terms of use of Windows
User information Register your name and the name of your

organization.
Product key Enter the Windows product key. (The key

is indicated on the label affixed to the
bottom of the machine.)

Windows password Register the user name and password.

Starting setup
1. Also, make sure that the AC adapter is connected before pressing

the power switch.
The CASIO logo screen is displayed, following by several other
screens, and finally the Windows setup screen.
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2. Confirm the terms of the Windows 2000 operating system licensing
agreement. Be sure to read these terms. If you agree with the terms
of this agreement, select “I accept this agreement.”, and click Next.
If you do not agree to these terms, you cannot use Windows 2000
operating system provided on FIVA.

• To read all, use the ▲ or ▼ button, or PgUp  ( Fn  + ↑  ) or
PgDn  ( Fn  + ↓  ) button to scroll the screen.

3. Set the location where FIVA is to be used.
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To display the next letter in the
next cursor position, you need
to release the CTRL key. As
long as you hold down the
CTRL key, the current cursor
position will just be
overwritten.

4. Next, the user information screen for setting details relating to the
individual using the software is displayed.
Register your name and the name of your organization. When you
have entered your name, press the tab. The cursor moves to the
textbox for entering the name of your organization.

• Personal settings in the software
Enter your “Name” and your “Organization name” here. Entering
characters is done by using both the CTRL key and the number keys.

Key Change characters Description

CTRL+ “8” The entire alphabet
in ascending order.
abcdefg...

CTRL+ “9” The entire alphabet
in descending
order.
zyxwvut...
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Input example: If your name is fiva

Name  fiva

f While holding down the CTRL key, press “8” repeatedly, when
“f” appears, release the CTRL key and the “8” key.
“f” is displayed on the screen.

i While holding down the CTRL key, press “8” repeatedly, when
“i” appears, release the CTRL key and the “8” key.
“i” is displayed on the screen.

v While holding down the CTRL key, press “9” repeatedly, when
“v” appears, release the CTRL key and the “9” key.
“v” is displayed on the screen.

a While holding down the CTRL key, press “8” repeatedly, when
“a” appears, release the CTRL key and the “8” key.
“a” is displayed on the screen.
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5. Enter the Windows product key.
(The key is indicated on the label affixed to the bottom of the
FIVA.)
If you make a mistake when entering the product key, an error will
be displayed, and you can enter the product key again. This key
will be needed when you ask for customer support, or when you
set up Windows 2000 again. Take care not to allow it to get dirty
as it cannot be re-issued.
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To display the next
letter in the next cursor
position, you need to
release the ALT key. As
long as you hold down
the ALT key, the
current cursor position
will just be overwritten.

• Product key
The product key combines the ALT key, the “8” key and the “9” key
for English letters and numbers only. Product key numbers are input
from the 10 key.
For English letters, while pressing the ALT key, repeatedly press the
“8” key or the “9” key until the appropriate letter appears. When the
appropriate letter appears, release the ALT key to set the letter.
If you want to make corrections, if the letter to be corrected is the
preceding letter, press the BS key, or touch the appropriate letter with
the stylus and input it again.

Key Change characters Description

ALT+ “8” Letters that are valid as
product IDs are shown in
order in the parenthesis.
(BCDFGHJKMPQRTVWXY)

ALT+ “9” Letters that are valid as
product IDs are shown in
order in the parenthesis.
(YXWVTRQPMKJHGFDCB)

Input example: If the first five characters are WJ6BT.
Product key (P)

WJ6BT - - - -

W Press the “9” key while pressing the ALT key. Pressing “9” one
time displays y->x->w, when “w” appears, release the ALT key
and the “9” key.

J Press the “8” key while pressing the ALT key. Pressing “8” one
time displays b->c->d, when “j” appears, release the ALT key
and the “8” key.

6 For numbers, press only the “6” key.
B Input “B” the same way as above.
T Input “T” the same way as above.
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6. The screen for entering the name of the computer and the
administrator (system manager) password is displayed.

7. Setting the date and time
Set the correct date and time to FIVA.
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8. Set the network settings.
In this screen, you must enter information that is common not only
to FIVA but that is also shared with other computers over a
network. If you do not know this information, ask the system
administrator of the network you are using or the system
supervisor at the store of purchase.

Continue with the settings for the "work group and the domain."
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9. In the exit Windows 2000 operating system setup screen, select
Exit.
This reboots FIVA, and the Windows 2000 initial screen is
displayed.

10. Enter the user name and password in this field to log on.

After doing the input, setup closes and the Windows desktop
screen returns.
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Shutting Down the Power

There are 3 ways to shut down the power. However, power
consumption with the power off, and the time until Windows can be
used again vary according to how FIVA is stopped and power is shut
down.
Select the appropriate method after having fully understood the
details in the following table:

Note
• FIVA’s default settings cause it to enter the Stand by Mode if you

do not perform any key or Keypad operation for about 10 minutes
under battery power alone. After another 10 minutes continuously
without operation, FIVA enters into the Hibernation Mode.

Important FIVA with the power source only from battery packs may not
completely recover if left in the Stand by Mode for a very long time.
If you do not plan to use FIVA for long time, turn it off or put it in the
Hibernation Mode.
Do not connect a peripheral to the FIVA, or do not disconnect it, in
the Suspend Mode.

There are 2 ways of turning FIVA off.

Pressing the power switch
Pressing the power switch allows you to set [Stand by], [Hibernate] or
[Shutdown].
Holding the power switch for at least 4 seconds sets [Forced Exit]
and forcibly turns the power off. (page 129)

Important Holding down the power switch for at least 4 seconds resets,
forcibly shuts down and turns FIVA off. Perform this operation only
when operation locks up and nothing else works. Do not perform
this in other instances.

Mode Power  Power Time Unit Storage
Supply      Indicator Lamp Recovery for state

qPower Off No need Off Long (restart) None

wStand by Need Flashing Fast Memory

eHibernate No need Off Long Hard Disk
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To shut down Windows 2000 operating system from the Start menu
Selecting [Shut Down...] from the Start menu ( )
[Shutdown], [Restart], [Stand by] and [Hibernate] can be selected in
the Windows Shutdown dialog box.

The following describes how to shut down from the Start menu
( ).
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Selecting [Shutdown] in the Windows Shutdown dialog box
This shuts down Windows and turns the power off.
Select this method when FIVA is not to be used for a long time (for
example, when power is not to be turned on until the following day) or
when adding on memory.

1. Select "Shutdown".

2. Check the screen, and click OK.
This completely shuts down the system, and stops power supply.
When the power is turned on again, FIVA is rebooted from Windows,
so it takes a little while until you can perform operations on FIVA.
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Selecting [Restart] in the Windows Shutdown dialog box
This exits the currently active session, completely shuts down the
system, and then restart the system as in a normal bootup.
Select this method when you are experiencing a problem in the
application or when you want to change system settings.

1. Select "Restart".

2. Check the screen, and click OK.
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Selecting [Stand by] in the Windows Shutdown dialog box
Use this method when you have to leave your desk for only a short
time or you want to resume operation immediately after the previous
operation.
In the Standby mode, screen displays, Windows states and the states
of previously active applications are saved to memory so that they
can be immediately used. In this mode, the Power indicator lamp
flashes amber, and only a slight amount of power is constantly
consumed. To resume use of FIVA, lightly press the power switch to
reset FIVA to the previous state.

Important Set to the Hibernation mode to conserve power consumption when
FIVA is left unused for a long period when it is running on the
battery packs only.

1. Select "Standby".

2. Check the screen, and click OK.
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Selecting [Hibernate] in the Windows Shutdown dialog box
In the Hibernation mode, the state of Windows 2000 operating system
and previously active applications are saved to hard disk. (In the
Standby mode, they are saved to memory and a slight amount of
power is constantly consumed.) Also, almost no power is supplied.
To resume use of FIVA, lightly press the power switch to restart FIVA
operation from the previous state. (page 129)

1. Select "Hibernation".

2. Check the screen, and click OK.

This completely shuts down the system, and stops power supply.
When the power is turned on again, FIVA is rebooted from Windows,
so it takes a little while until you can perform operations on FIVA.
Select this method when FIVA is not to be used for a long time (for
example, when power is not to be turned on until the following day).
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Important • Avoid entering the Hibernation Mode while a communication
operation is in progress, or while a peripheral (disk, printer, etc.)
is in use. Entering the Hibernation Mode while a communication
operation is in progress will cause an error on the other
computer.

• The Standby Mode and Hibernation Mode are disabled in the
MS-DOS.

• You can reset FIVA and force power to turn off by holding down
the power switch for 4 seconds. Use this method to reset FIVA
only when operation locks up and nothing else works.
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How to Use Suspend

The FIVA unit is provided with the suspend of the power saving
function as standard.
Suspend refers to both the Hibernate and Stand by modes described
on the previous pages.
Use of the battery packs can be prolonged by suspending FIVA when
FIVA is not to be used temporarily. (The time that FIVA is held in the
suspend state varies according to the battery pack charge state.)

Lightly press the 
power switch and 
release immediately.Select [Hibernate] in the Windows Shutdown 

dialog box. (page 51)

Select [Stand by] in the Windows Shutdown 
dialog box. (page 50)

Press the power switch to select [Hibernate]. 
(page 129)

Press the power switch to select [Stand by].
(page 129)

Set the Standby mode by        +"3". (page 135)

Set the Hibernation mode by        +"4". (page 135)

Click the (       ) button in the Mobile Cockpit. 
(page 135)

Click the (       ) button in the Mobile Cockpit. 
(page 135)

Fn

Fn

Perform One of the Following
to Suspend FIVA

How to Cancel 
Suspend

Important • If you set FIVA to Stand by when it is running on the battery packs
only, the Power indicator lamp continuously flashes amber. When
the AC adapter is connected, the Power Indicator lamp flashes
green.
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Chapter 2
Using FIVA
This chapter explains how
to turn on power and per-
form a number of basic
computer operations.
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Adjusting the Screen Brightness

When you use FIVA, the brightness of the screen must sometimes be
adjusted. There are two ways of doing this, from the keyboard and
from the Mobile Cockpit.
q From the keyboard (page 29)

Fn  +"1" ( ) turns down (darkens) the brightness.
Fn  +"2" ( ) turns up (lightens) the brightness.

w From the Mobile Cockpit (page 130)
Click the brightness (       ) button in the Mobile Cockpit. You can
change the screen brightness in eight stages in the dialog box
that is displayed.
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Using the Stylus

Before actually using the stylus to perform screen operations, be sure
to first clean the tip of the stylus and the screen. Performing stylus
operations when the stylus or screen is dirty can damage the screen
and interfere with stylus input.
Use only the stylus that comes with FIVA to perform screen
operations. Never use a pencil, a mechanical pencil, or any other
pointed object. Such objects can damage the display.

When you touch the screen with the stylus, a pointer ( ) appears on
the display to indicate the point you touched. If the position on the LCD
screen you tap with the stylus moves, perform the calibration
immediately. If amount of the move is excessive, the calibration may not
be performed.

To calibrate the screen
1. Open the Taskbar, touch Start, Programs, FIVA TOOLS, and then

Calibration Tool. This causes the calibration screen shown below
to appear, with a cross mark in the upper left corner.
• You can also display the calibration screen by pressing Fn  +

“.”.

2. Tap the cross marks with the stylus in the sequence they appear
on the screen.

3. After you tap the final cross mark, a title bar appears in the title bar
at the bottom of the screen. Use the stylus to draw something on
the screen. Check to make sure line drawn on the screen appears
where you drag the stylus on the screen.
• Pressing Del deletes the line drawn with the stylus and moves

the title bar display up and down.
• If the line appears in the correct location, press Enter to exit the

calibration procedure.
• If the location of the line is not correct, press 0 and go back to

step 2 of the above procedure.
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Stylus Operations
With FIVA, you can perform all the operations you need by lightly
touching the screen. The following provides descriptions and examples
of a number of basic functions.

Important • Do not trace along the frame line on the LCD screen with the stylus,
or apply an excessive pressure when inputting on the screen as it is
easily damaged. Doing so may cause malfunction of the screen.

q Double-click
Tap twice on the screen in quick succession to accomplish the same
result as double clicking with a mouse.
w Drag
Touching an icon causes it to change
colors. Holding the stylus against the icon
and dragging causes the icon to move
along with the stylus.

e Drag and Drop (Depend on the application)
Drag and drop lets you move a selected range of text from one location
on the screen to another.

• Touch and hold the beginning of the range of text you want to select,
and drag stylus to the end of the range. Remove the stylus from the
screen when all the text you want is selected. Selected text is
highlighted on the screen as shown above.

• Holding the stylus anywhere inside the highlighted text, drag it to the
location to which you want to move it, and then remove the stylus
from the screen.
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r Right Click
Touch the  icon on the lower right of the screen. The next time you
touch the screen with the stylus performs a right-click operation.

Some applications do not allow right clicking while a range of text is
selected (highlighted).

Key lock
The key lock switch is located on the right side of the FIVA unit. This
switch has two settings LOCK and FREE, and is for preventing
wrongful entry on the keyboard. When this switch is set to LOCK,
wrongful entry on the keyboard is prevented even if the keyboard is
touched.
LOCK: Disables entry on the keyboard. (The keyboard backlight is
turned off.) The backlight for keyboard is not lightning.
FREE: Enables entry on the keyboard.
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Using the Keyboard

Keyboard Types
FIVA Hard Keyboard
The keys to the right of the FIVA display are grouped according to
function: control keys, 10-key pad, and arrow keys. Pressing the
function key Fn  and then another key performs a hot key function.
See page 29 for a complete list of hot key combinations.

Text Input Panel
There are two types of text input panels: Mobile Keyboard and
smARTwriter (a handwriting input panel). The most appropriate
keyboard for the type of operation you are performing appears list,
and you can switch between keyboards.

• smARTwriter (handwriting input panel)
Use this input panel to input text by hand writing directly on the
screen. smARTwriter cannot be used in combination with the Mobile
Keyboard.

• Mobile Keyboard
Use this keyboard when setting up the system and performing other
input. Press the Fn  and “–” keys to display the Mobile Keyboard.
The Mobile Keyboard has the same configuration as a computer
keyboard. You cannot use the Mobile Keyboard and the smARTwriter
at the same time.

 MPC701M50E#p57~64 02.11.22, 10:12 AM61



62

Changing the Mobile Keyboard Size
Touch and hold the lower right corner of the keyboard with the stylus
so the pointer changes from   to . Drag the stylus on the
screen to change the size of the keyboard. Note that the size of the
smARTwriter handwriting input panel cannot be changed.

Moving the Mobile Keyboard on the Screen
Hold and tap the  area on the left side of the keyboard and drag it
to the location you want.
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Inputting Text with the Mobile Keyboard

There are five different Mobile Keyboard configurations. You can
select the one that suits you best. To change the configuration of the
Mobile Keyboard, tap the  icon in the upper left corner of the
current keyboard, and then select the keyboard you want from the
menu that appears.

q Full Qwerty key

w Middle Qwerty key

e Small Qwerty key

r ABC key
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t Ten key
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Using handwriting input (smARTwriter)

FIVA comes with smARTwriter handwriting recognition software. You
can find detailed information about all of the features and functions in
the online help that is available while smARTwriter is running. The
following explains of smARTwriter Plus Ver.3.5.
smARTwriter is a pre-installed handwriting recognition application that
lets you input text into an active application, launch applications,
open documents and more by writing with the stylus directly on the
FIVA screen.
Writing on any part of the FIVA screen creates “electronic ink,” which
is then recognized and interpreted by smARTwriter. Finally, the results
are sent to the active application as if they were typed using a
keyboard.

How does it work?
“Electronic ink” appears as you write on the FIVA screen. When a
timeout occurs (when you lift the stylus for a certain time interval),
smARTwriter passes the recognized output to the active application.
The recognition process is performed by comparing the symbols you
write against a set of defined smARTwriter symbols. This set of
symbols is called a Library. The Library contains shapes of letters,
digits, punctuation marks, etc.
The Library can contain more than one version of a letter or symbol.
The letter “G,” for example may be written as shown below:

smARTwriter has a generic library containing common handwriting
styles for characters, so your handwriting probably will be easily
recognized the first time you use smARTwriter.

Training smARTwriter
Training lets you teach smARTwriter your own handwriting style,
which improves the recognition rate. You can train smARTwriter using
any of the methods listed below.
• Quick Trainer. This is an automatic tool for adding letter models to

the Library (page 66).
• On-the-spot training. You can correct a recognition error whenever

one occurs.
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Achieving Good Recognition
Following the tips listed below helps to improve the handwriting
recognition rate.
• Write without stopping. There is no need to wait for smARTwriter to

recognize text.
• Write using printed (not connected or cursive) characters.
• Do not use delayed strokes. Dot your “i” and cross “t” characters

immediately.
• Avoid touching the screen with your hand while writing. Doing so

can leave unwanted ink on the screen.
• Avoid writing small characters. Doing so can cause loss of

resolution and character recognition errors.
• After using smARTwriter for a few days, we recommend that you

edit the Library and delete any redundant or incorrect models. See
“Library” on page 78 for more information.

Using Quick Trainer
Quick Trainer is an application you can use to teach smARTwriter
your particular style of writing, which helps to improve recognition
results. It takes less than five minutes to complete one Quick Trainer
session.

To run Quick Trainer
1. Start up Quick Trainer by selecting: Start → Programs →

smARTwriter for Windows → Quick Trainer.
2. A prompt appears asking if you want to train Western European

characters.
• If you want to train using standard English characters, tap No and

then tap OK.
• If you want to train using other (non-standard English) characters,

tap Yes and then select the language from the pull down menu on
the right. Next, tap OK.
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3. The Quick Trainer window appears, showing a passage of text.

4. Copy each character into the slot or box directly under it, one
character in each slot. If you make a mistake, re-write the letter or
character. You can re-write a letter or character as many times as
you need. Make sure you write characters in all the slots provided.
Letters that smARTwriter immediately recognizes will be
highlighted. The rest will be learned by the recognition system
when you tap the Accept button.
The bar at the bottom of the window indicates the progress of the
session.

5. After you finish writing all the characters, tap the Accept button. If
you want to clear the screen and start over, tap the Clear button.

Note
• You can repeat Quick Trainer sessions as often as you want.

Repeating sessions improves recognition results even more.

Using the Euro Trainer
Using the Euro Trainer, you can train smARTwriter to recognize your
handwriting in Western European languages other than English.
To launch training for non-English Western European characters,
select Start → Programs → smARTwriter for Windows → Euro
Trainer.
A prompt asks you to choose a Western European language. Select a
language, and tap OK. Then follow the instructions described above
in Using Quick Trainer.
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Using smARTwriter
This section explains what you need to know in order to actually set
up and use smARTwriter on your FIVA.

Starting Up smARTwriter
smARTwriter always starts up automatically every time you turn on
FIVA. You can, however, quit smARTwriter manually (selecting Exit
from the smARTwriter menu option), and then start it back up
manually the next time you want to use it.

To start up smARTwriter manually
1. On your FIVA, select: Start → Programs → smARTwriter for

Windows, and then tap the smARTwriter shortcut icon.
2. The above step causes the smARTwriter control icon to appear in

the icon tray in the bottom right corner of the screen. This indicates
that smARTwriter is active.

smARTwriter Modes
You can control stylus operations and handwriting recognition using
the smARTwriter icon in the bottom right corner of the screen.

The shape of the icon indicates the current mode.
• Pointing Mode ( )
This icon indicates that the stylus operates as a pointing or selection
device.
• Writing Mode ( )
This mode indicates that the stylus operates as a writing device.
Tapping the icon toggles between the modes.
Double-tapping the icon or holding down the Alt key and tapping the
icon, opens the smARTwriter menu.
• Pen-Aware mode ( )
This is an automatic mode used by applications with several input
fields. Pen-aware applications (such as ART’s Quick Trainer) switch
back and forth between the Writing and Pointing modes according to
the stylus’s position on the screen.

smARTwriter tray icon
(Writing Mode)
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First Steps in Writing with smARTwriter
1. Switch to Pointing Mode( ) and then start up an application, such

as Word.
2. Switch to Writing Mode ( ) and tap in the input area of the

application so the insertion cursor appears. You are ready to start
writing on the screen.

3. Using the stylus, write a few words in the Pocket Word document
area. Write continuously. It is not necessary to pause after each
letter. smARTwriter reads the “ink,” recognizes it, and converts it
into printed text.

4. The recognized text appears at the insertion point.

Note
• Recognized text is always inserted to the left of the cursor in the

active window.
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Using Gestures
A “gesture” is a symbol you draw to activate a special function or
enter a special character, like a backspace, new line, etc.
The following are the gestures available with smARTwriter.

Note
• The heavy dot indicates the starting point of each gesture.

For example, the following describes the steps you should perform
when you want to use the Backspace gesture.
1. Switch to the Writing Mode ( ).
2. Draw the Backspace gesture on the screen.
3. This causes the character to the left of the cursor position to be

deleted.

Activating the Correction Box
The Correction Box is a built-in tool that makes it easy to correct
misrecognized text. You can use any of the three different procedures
to activate the Correction Box.

To activate the Correction Box with the Correction gesture
1. Write until a recognition error occurs.
2. Draw the Correction gesture over the word you want to correct.

• This selects the word and activates the Correction Box with the
misrecognized word inside it.

Correction

Backspace Space New Line

Edit Selected Edit Selected Tab

Training Backspace
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To activate the Correction Box with the menu
1. Write until a recognition error occurs.
2. Select (highlight) the misrecognized word.
3. Tap the smARTwriter icon and then select Correct... from the

smARTwriter menu.
• This activates the Correction Box with the misrecognized word

inside it.
To activate the Correction Box with an Edit Selected gesture
1. Write until a recognition error occurs.
2. Select (highlight) the misrecognized word.
3. Draw either of the Edit Selected gestures.

• This activates the Correction Box with the misrecognized word
inside it.

Using the Correction Box
The Correction Box displays the characters that make up the
selected word with a down arrow underneath each one.

To make corrections
1. Tap the down arrow under the character you want to change. This

displays a menu of other possibilities for the character.
2. Choose the character you want by tapping it. You can also change

a character by writing the new character directly into the box or
slot on the Correction box.

Note
• The menu that appears when you tap a down button also

contains two commands. Tapping Ins inserts a space in front of
the current character, while Del deletes the current character or
space.

3. Tap the Replace button to replace the original word with your
corrected version. To delete the word from your input, tap the
Delete button.
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The smARTwriter Menu
Tapping the smARTwriter icon opens the smARTwriter menu, which
provides access to the main functions of smARTwriter.

Correct
Activates the Correction Box. See “Using the Correction Box” on
page 71.

Train
Opens the Trainer dialog box so you can “teach” smARTwriter your
handwriting style. See “Training smARTwriter” on page 65.

Library
Opens the Library Manager. See “Library Models” on page 79.

Properties
Displays the smARTwriter Properties dialog box. See “Properties” on
page 81.

Help
Displays smARTwriter online help or copyright and version
information.

Exit
Tap here when you want to manually shutdown smARTwriter.

Pen mode
Toggles between the smARTwriter Writing mode ( ) and Pointing
mode ( ). See “smARTwriter Modes” on page 68.

Tap here.
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Train
You can train smARTwriter to recognize your own handwriting style for
characters, strings, macros, gestures, or application shortcuts.

Note
• Training improves the handwriting recognition rate because it

teaches smARTwriter how to recognize your particular writing
style. See “Using Quick Trainer” on page 66 for information about
how to use another training tool named Quick Trainer.

To access training while you are inputting text, tap the smARTwriter
icon in the icon tray, select Train from the smARTwriter Menu, and
then select one of the training options: Character...,
Macros and Gestures..., or Application Shortcuts....

Character
This option opens the Trainer dialog box. You can also draw the
gesture shown below to open the Trainer dialog box.

When the Trainer dialog box opens, it shows the last ink pattern you
wrote or selected. Use this dialog box to teach smARTwriter to
interpret the pattern (or a part of it) as a single character.

To teach smARTwriter a character
1. Display the Trainer dialog box by tapping the smARTwriter icon and

then selecting Train → Character....
• The last ink pattern you drew is shown in the upper part of the

Trainer dialog box.
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2. In the upper part of the Trainer dialog box, select the segments or
parts of the ink pattern that you want to use as a character.

Note
• Tap the ink pattern to select it, tap it again to deselect. If there is

more than one stroke, make sure you select all the strokes that
are part of the character. The strokes you select appear in the
Trainer dialog box, which shows the ink pattern that will be used
for recognition.

3. Tap the down arrow next to the As box and select the character
from the list that appears.

• If you cannot find the character you want in the list, select Other.
See “Other Symbols” below.

• You can also use the stylus to write the text character you want
directly into the As box.

• No matter how you specify a character, the character in the As box
will be associated with the ink pattern in the Trainer dialog box.

4. Tap the Train button to train the character and save your changes
to the Library of Models.

5. Tap the close box  to close the Trainer dialog box.

Other Symbols
If the character you want is not in the list, select Other from the list to
open the Train Symbol dialog box.

The Train Symbol dialog box provides a selection of non-standard
and international symbols. Tap the character you want on the Train
Symbol dialog box to select it, and then tap OK.
The following functions are also available on the Trainer dialog box.
• Tap the Undo button if you made a mistake and want to “untrain”

the character.
• Tap the Macro button when you want to train the selected ink

pattern as a character string, macro, or gesture. Tapping Macro
displays the Train Macro Wizard, which shows the selected ink
pattern. See “Macros & Gestures” on page 75 for more information
about this dialog box.
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Note
• If you open the Trainer dialog box while text is selected in a

document, the selected text is automatically replaced by the
newly trained character when you close the Trainer dialog box.

Macros & Gestures
This option opens the Train Macro Wizard dialog box with the last ink
pattern you wrote or selected. Use this dialog box to teach
smARTwriter to interpret the pattern as a character string, macro, or
gesture.

To teach smARTwriter a character string, macro, or gesture
1. Display the Train Macro Wizard dialog box by tapping the

smARTwriter icon and then selecting Train → Macros & Gestures.
• The last ink pattern you drew is shown in the Draw Macro Ink box.

• You can use this pattern as it is, or you can replace it with another
pattern by tapping the Clear Ink button and then drawing another
ink pattern.

2. When the ink pattern is the way you want, tap the Next button to
continue.

• To cancel training, tap the Cancel button.
3. In response to the prompt that appears, tap New Macro if you are

creating a new macro, or Existing Macro or Gesture to associate
the ink pattern with an existing macro. Next, tap Next to continue.

What happens next depend on whether you selected New Macro or
Existing Macro or Gesture in step 3 of the above procedure.

New Macro
1. In response to the prompt that appears, use the stylus to enter a

name for the macro or gesture. The name you enter appears in the
Enter Macro Name box. After you are finished, tap Next to
continue.

2. Use the stylus to enter the macro sequence or character string.
• Characters are displayed as characters.
• Functions are displayed as the functions they represent. For

example, a tab operation appears as <TAB>.
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3. Tap Finish to save the macro and close the Train Macro Wizard.

Existing Macro
1. On the dialog box that appears, select the macro or gesture you

want from the list.

• The lower part of the dialog box shows the sequence currently
assigned to the selected macro or gesture.

2. Tap the Finish button to save your changes and close the Train
Macro Wizard.

Application Shortcuts
This option opens the Train Shortcut Wizard dialog box with the last
ink pattern you wrote or selected. Use this dialog box to teach
smARTwriter to interpret the pattern as a shortcut to launch an
application.

To teach smARTwriter an application shortcut
1. Display the Train Macro Wizard dialog box by tapping the

smARTwriter icon and then selecting Train → Application
Shortcuts.

• The last ink pattern you drew is shown in the Draw Macro Ink box.

• You can use this pattern as it is, or you can replace it with another
pattern by tapping the Clear Ink button and then drawing another
ink pattern.

2. When the ink pattern is the way you want, tap the Next button to
continue.

• To cancel training, tap the Cancel button.
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3. In response to the prompt that appears, tap New Shortcut if you
are creating a new shortcut, or Existing Shortcuts to associate
the ink pattern with an existing shortcut. Next, tap Next to
continue.

Note
• The prompt described in step 3 appears only when one or more

application shortcut already exists. If there are no application
shortcuts yet, the New Shortcut option is selected automatically.
What happens next depend on whether you selected New
Shortcut or Existing Shortcuts in step 3 of the above
procedure.

New Shortcut
1. Tap the Browse button. On the dialog box that appears, select the

application for which you want to create a shortcut and then tap
OK.

2. The path to the application you selected appears in the Shortcut
command line box, and the name of the application appears in
the Shortcut name box.

3. Tap Finish to save the shortcut and close the Train Shortcut
Wizard.

Existing Shortcuts
1. On the dialog box that appears, select the shortcut you want from

the list.

• The lower part of the dialog box shows the path to the application
currently assigned to the selected shortcut.

2. Tap the Finish button to save your changes and close the Train
Shortcut Wizard.
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Library
The collection of characters and shapes recognized by smARTwriter
is called the Library of Models. smARTwriter contains a pre-defined
Library of Models with over 371 distinct characters.
smARTwriter recognizes handwriting primarily by comparing the
shape and direction of flow of individual characters you write to a set
of character shapes (models) stored in the Library of Models. Every
time you train smARTwriter, you add character models to the Library
of Models. To improve recognition, you should periodically use
Library Manager to delete redundant or unnecessary models from the
library.

Library Manager
Library Manager lets you maintain the list of character shapes and
symbols in a specific Library of Models. This is especially useful if
your FIVA is used by more than one person. You can create a Library
of Models for each user, so smARTwriter can recognize each
individual’s personal handwriting style.

To open Library Manager
Tap the smARTwriter icon and then select Library... from the menu.

Library Name
This is the name of the currently active library. It also shows the total
number of models in the library. Normally, the Library Name is the
same as the user name.

Library Name

Type of Models

Library Models
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To view: Select:

All characters in the Library of Models All

Lower case characters only Lower

Upper case characters only Upper

Numbers only Digits

Symbols and punctuation marks only Punc.

Gestures only Gestures

Macros only Macros

Shortcuts only Shortcuts

Type of Models
Use this box to specify the category of models you want to view. Tap
the down arrow and select one of the categories listed below.

You cannot use this box to view macros and shortcuts.

Library Models
This box lists all the characters, gestures, macros, and shortcuts in
the library. It lets you select a specific character and review its
associated models. To view the models associated with a specific
character, select a category from Type of Models list. Then tap a
character in the Library Models list. The database of models for the
character you select appears in the Models Box.

Models Box
This box shows the models assigned to character. The total number
of models assigned to the selected character is shown above the
Models Box.
Use the scroll bar to view the different character models assigned to
the selected character. The leftmost model is the last model assigned
to the character.
To select a model, tap it once.

Delete Button

Note
• This button is dimmed (unavailable) unless a macro or a shortcut

model is selected in the Models Box.

Tap this button to delete the selected model from the library.

Libraries Button
Tap this button to display the Libraries Window.
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Using the Libraries Window
Use the Libraries Window to create new libraries, open an existing
library (change the active library), and to copy and delete libraries.
The icons on the top of the Libraries Window represent New (create),
Open (change), Copy, and Delete.

Creating a New Library
If more than one person uses the FIVA, it is a good idea if each user
creates a personal Library of Models.

To create a new library
1. Tap the New button ( ).
2. In response to the prompt that appears, enter the name you want

to give the new library, and then tap OK.
• Normally, you should use the name of the user as the name of the

library.
3. On the New Library dialog box that appears on the display, select

one of the followings as the type of Library you want to create.

4. Tap OK

Note
• Whenever you create a minimal library, smARTwriter automatically

launches Quick Trainer. See “Using Quick Trainer” on page 66.

To open an existing library and change the active library
1. On the Libraries Window, select the library you want to open from

the list of libraries.
2. Tap the Open button ( ).

To copy a library and save it under a different name
1. On the Libraries Window, select the library you want to copy from

the list of libraries.
2. Tap the Copy button ( ) to display the Copy Library dialog box.
3. Enter the name you want to assign to the copy of the library.
4. Tap the OK button to save the copy.

When you want to:

Load the standard smARTwriter library, with
the full range of default model samples

Load all punctuation marks and predefined
gestures and shortcuts only.
• This case, you must train smARTwriter to

recognize your handwriting style. See
“Training smARTwriter” on page 65, and
“Using Quick Trainer” on page 66.

Select:

Standard default
lilbrary.

Minimal lilbrary.
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To delete a library

Note
• Make sure that the library you are deleting is not the active library.

If it is, change the active library.
1. On the Libraries Window, select the library you want to delete from

the list of libraries.
2. Tap the Delete button ( ).

Properties
This menu option displays a dialog box for setting the properties of
smARTwriter. The Properties dialog box contains the following tabs.

General
This tab contains settings for customizing smARTwriter behavior.

Timeout
Sets the time smARTwriter waits from the moment you lift the pen from
the screen before it begins recognition of the “ink” pattern. The range
is from 0.1 to 1.5 seconds.

Enhanced recognition of English
Checking this box enables the smARTwriter linguistic layer, which
allows smARTwriter to recognize rules and guidelines for the English
language. For example, if the “g” in “reading” is written very similar to
a “y,” the linguistic layer knows that “iny” is not a common ending in
English and that “ing” is a more probable combination. Therefore,
smARTwriter outputs “reading” as the recognized word.
Enhanced Recognition of English is checked by default. You should
disable this option if you are not writing standard or plain English text.

Space after recognition
When this option is checked, smARTwriter adds a space after each
set of characters recognized (after each timeout).

Enable Sounds
When this option is checked, smARTwriter plays error and warning
sounds through the FIVA’s speaker.
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Ink
The settings on this tab control the way the electronic ink is displayed
on the FIVA screen.

Ink Width
Use this setting to change the width of the ink. Tap the up or down
arrow to change the width within the range of 1 to 5 points.

Ink Color
This area shows a sample of the color currently selected for the ink,
and provides a button for changing the color.

To change the color of the ink
1. Tap the Change... button to display the Color dialog box, which is

a standard Windows color palette.

2. Select the color you want to use for the electronic ink.

Note
• Refer to your Windows documentation for more information about

using this dialog box.
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Orientation

Note
• This option affects smARTwriter only. The screen orientation of

your other applications does not change.

These settings let you adjust the position of the screen for use as a
writing board. They define the writing orientation so smARTwriter can
recognize the electronic ink pattern.

Ink Filter
Use these settings to correct ink patterns and help improve
recognition.
• Smooth out jagged ink
Check this option to eliminate “dotting” and make electronic ink
appear smooth. For optimal recognition, make sure that this setting is
the same for both writing and training sessions.
• Eliminate random ink spikes
Check this option to remove sharp ink edges, making the edges of
the electronic ink appear rounded. For optimal recognition, make sure
that this setting is the same for both writing and training sessions.

Hot Key
Use this tab to create a hot key or shortcut that toggles between the
Writing Mode ( ) and Pointing Mode ( ). You can tap a radio button
to select a predefined hot key, or select Other to define your own
shortcut. When you specify one of the Ctrl and Shift options, the
toggle is performed after you press and release the applicable key.
• You cannot select Right Shift and Right Ctrl options with FIVA .
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Constraints
This tab lets you turn recognition filters on and off. Turning on filters
helps to improve recognition.
As explained previously, smARTwriter searches through a large
number of symbols in the Library of Models to find a match for each
character you write. If you are inputting only characters from a certain
group (lower case, numerals, etc.), you can constrain (limit) the
search to those character groups and minimize recognition errors.
To constrain the search, uncheck the character set(s) you are not
using. You may check or uncheck any combination of sets to fit your
writing style.

Note
• For every recognition operation, smARTwriter searches through all

the character sets that are checked  on the Constraints tab.

The following is an example of using Constraints.
1. Tap the smARTwriter icon in the icon tray and select Properties....

Next, display the Constraints tab.

2. On the Constraints tab, uncheck all sets except Lowercase and
then tap OK.

• Now anything you write will be interpreted as lower case letters.

Quitting smARTwriter
Use the following procedure to manually quit smARTwriter when
necessary.

To quit smARTwriter
1. Tap the smARTwriter icon in the icon tray.
2. Select Exit from the Menu.
3. On the confirmation dialog box confirming whether you want to quit

smARTwriter, tap Yes.
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Using smARTscribble

Basic Concepts

About smARTscribble
smARTscribble is a sketching application you can use to draw on the
screen and capture the ink pattern. The resulting image is a set of
stylus strokes you can edit later. smARTscribble also lets you add text
to the image.
The following are just some of the ways you can use smARTscribble.
• Taking handwritten notes - instantly put your ideas in writing.
• Drawing images, sketches, road maps, etc. with explanatory text.
• Combining any part of the ink or text with other Windows

applications such as Microsoft Word.

Starting Up smARTscribble
Select Start → Programs → smARTwriter for Windows and then
tap the smARTscribble shortcut icon.

Working with Images

To draw an image
Simply use the stylus to draw on the screen of the FIVA as if you were
drawing on paper.

To edit an image
Use standard Windows editing procedures to edit images with
smARTscribble. In other words, select the image and then edit it
using Cut, Copy, Paste or Delete. You can access editing features
by selecting them on the smARTscribble Edit menu or by using
keyboard shortcuts.
You can also use the editing features of smARTscribble to paste
images copied or cut from one document into another document.

Selecting Images

To select a single image
1. Tap the Selection Boundary button ( ) on the smARTscribble tool

bar. The button remains pressed until the selection procedure is
complete.

2. Drag the stylus diagonally across the area containing the image
you want to select. A selection boundary appears on the screen
where you drag the stylus.
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3. Lift the stylus from the screen. All the strokes contained within the
selection boundary become highlighted. Strokes that are partially
within the selection boundary are also highlighted.

Note
• Selecting as area or image automatically cancels  any previous

selection on the screen.

To select all the images on the screen
On the Edit menu, tap Select All.

To delete an image
Select the image and then tap the Delete button ( ).

To cut an image
Select the image and then tap the Cut button ( ). This deletes the
image from the screen and places it onto the clipboard.

To copy an image
Select the image and then tap the Copy button ( ). This places a
copy of the image onto the clipboard without affecting the original
image.

Note
• Copied images can be pasted into documents created with other

applications, such as Word.

To paste an image from the clipboard
1. Tap the Paste button ( ).
2. Drag the pasted image (which is surrounded by a selection

boundary) to the location you want it.
3. Tap anywhere outside the selection boundary to deselect the

pasted image.

To move an image
1. Select the image.
2. Drag the image to its new location with the stylus.

Working with Text
With smARTscribble, you can add text anywhere in a smARTscribble
document. Each text line you enter is considered a separate object
containing a single line of text.

To add new text
1. Tap the Text button ( ) to switch to the text mode.
2. Tap the location in the document where you want to place the new

text, and a text box appears on the screen.
3. Enter text into the text box.
4. After you are finished, tap anywhere outside the text box or tap the

Text button again to finish entering text.
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To modify existing text
1. Tap the Text button ( ) to switch to the text mode.
2. Tap the text item you want to edit.
3. Make any changes you want.
4. After you are finished, tap anywhere outside the text box or tap the

Text button again to finish entering text.

Editing Text
Use standard Windows editing procedures to edit text with
smARTscribble. In other words, select the text and then edit it using
Cut, Copy, Paste or Delete. You can access editing features by
selecting them on the smARTscribble Edit menu or by using keyboard
shortcuts.

To select text
• To select a whole word, double-tap the word.
• To select a string of consecutive letters or words, drag the stylus

across the text you want to select.

To delete text
Select the text and then tap the Delete button ( ).

To cut text
Select the text and then tap the Cut button ( ). This deletes the text
from the screen and places it onto the clipboard.

To copy text
Select the text and then tap the Copy button ( ). This places a copy
of the text onto the clipboard without affecting the original text.

Note
• Copied text can be pasted into documents created with other

applications, such as Word.

To paste an image from the clipboard
Open the text box where you want to paste the text and then tap the
Paste button ( ).

Note
• Text copied from other applications can be pasted into a

smARTscribble text box.

To insert the date and time into a page
On the File menu, tap Time Stamp to paste the date and time into the
upper right corner of the active page.
To remove the date and time, deselect the Time Stamp option on the
File menu.
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Ink

Changing the Ink color

To change the color of the ink
1. On the Edit menu, tap Pen Color to display the Color dialog box,

which is a standard Windows color palette.

2. Select the color you want to use for the ink.

Note
• For more information about using this dialog box, refer to your

Windows documentation.

Changing the Ink width
smARTscribble supports three ink widths: thin, medium and thick. The
currently selected width is always shown on the toolbar in the Ink
Width box.

To change the ink width
1. Tap the Ink Width down arrow.

2. This displays the three available width options. Tap the width you
want to select it.
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smARTscribble Documents

Creating, Saving and Opening Documents
smARTscribble documents can be saved as files.

Note
• smARTscribble document files have names that end with the

extension INK. Any file with this extension is automatically
associated with smARTscribble.

• To create a new smARTscribble document, tap New on the File
menu.

• To save a smARTscribble document under its current name, tap
Save on the File menu.

• To save a smARTscribble document under a different name, tap
Save As on the File menu.

• To open an existing smARTscribble document, tap Open on the
File menu.

• To save the current page in bitmap format (that you can print),
select Export Page as Bitmap on the File menu.

Navigating Around a Document
A smARTscribble document can have up to 20 pages of ink (images)
and text. To scroll through the pages of a document, tap the  or 
button. The number between the buttons indicates the current
document page number.

Guidelines
smARTscribble lets you display guidelines to help you align your
images and text. You can select either gridlines or horizontal lines.

To show guidelines
On the View menu, tap either of the followings
• Grid: Displays a grid of dashed guides.
• Lines: Displays thin horizontal guides.

To hide guidelines
On the View menu, tap the currently selected guideline style (Grid or
Lines) to deselect it.
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Page Size
Each new smARTscribble document page is sized to fit the FIVA
screen. Use the Expand ( ) to expand the size of the document
page.
• To lengthen the size of a page, tap the Expand ( ) button.
This causes the page to expand downwards. You can view the area
of the page off the bottom of the screen by using the vertical scrollbar
on the right of the page.

Note
• When you switch between pages, smARTscribble automatically

adjusts the page size so all the data fits on the page.

Previewing a Document

To preview the current page:
1. On the View menu, select Page Preview.
• This displays the Page Preview window, which shows the contents

of the entire page.
2. To close the Page Preview window, tap the Close button.
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Using the Battery Pack

A charged battery pack lets you run FIVA without connecting the AC
adapter. The following describes various power management
functions that help to make battery pack operation more efficient.

Note
• See page 32 for information about attaching and removing the

battery pack. See page 34 for information about charging the
battery pack.

Checking the Current Charge Level of the Battery Pack
The battery pack discharges naturally even when you are not using it.
Make sure you charge the battery pack fully before trying to use it to
power FIVA.
You can use any of the following three methods to check the current
charge level of the battery pack.
• The color of the BAT-LED indicator lamp
• The color of the PW-LED indicator lamp
• Mobile Cockpit

Checking the Battery Indicator Lamp Color

If the battery indicator lamp lights green when the AC adapter is
connected, this indicates that charging of the battery pack is
completed. (page 35) When FIVA is used in this state, the "COMPLETE"
message is displayed on the Mobile Cockpit tool bar.

When the battery indicator lamp lights amber, this indicates that
charging is in progress. Continue use while charging the battery
pack.

BAT-LED
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Checking the Power Indicator Lamp ColorBAT-LED

When there is little remaining battery power left when FIVA is running
on the battery pack only, the Power Indicator lamp ( ) starts to flash
red, and the system notifies the user by the low battery power warning.

If you ignore this warning and continue using FIVA without the AC
adapter connected, FIVA will automatically enter the Hibernation
mode.
Perform one of the following to continue use when the battery
warning is displayed:

• Turn the power off, and connect a charged battery pack.
• Connect the AC adapter to FIVA and use FIVA while charging the

battery pack.
• Suspend FIVA, and replace with a charged battery pack.

Important • Turning on power while battery power is below the trigger level for
low battery warning causes the warning message to appear on the
display (Battery power is below XX%.) and power to turn off
automatically. When this happens, connect the AC adapter to
power FIVA.

 Power Indicator Meaning

Lit Amber FIVA being powered by battery pack.

Flashing Amber When using battery power only,
indicates the Standby Mode.

Flashing Red When using battery power only,
indicates low battery power.

Lit Green FIVA being powered by AC adapter.

Flashing Green Standby Mode (AC adapter is used)

PW-LED

 MPC701M50E#p85~96 02.11.6, 5:53 PM92



93

2

Checking with Mobile Cockpit
Mobile Cockpit’s battery monitor function lets you graphically view the
charge level of the battery at any time. See page 134.
For more information on the battery pack, press the battery control
button to display some on-screen information.

Battery control button

Click.

Battery information is displayed here.

Using the Battery Pack Effectively
The amount of operating time you get from the battery pack is greatly
affected by operating conditions and how you use it.
FIVA’s  mobile computing Power Management functions help to
ensure that you get maximum power out of the battery pack. See
page 126.

Note
• You can extend your running time by taking the battery out when

you have finished using it. But, the battery will slowly lose power
even if it is not installed. To be able to use FIVA whenever you
want, you should recharge the batteries occasionally.

Forced Hibernation Mode
To help ensure that you do not lose application data files, FIVA goes
into forced Hibernation mode whenever the battery charge level
drops below a certain point. When this happens, connect the AC
adapter or change the charged battery pack and press the power
switch to recover from the Hibernation mode.
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When to Replace the Battery Pack
The battery pack is a consumable item, and after long use the
amount of operating time provided by a fully charged battery can
become quite short. This indicates it is time to replace the battery
pack with a new one.
The Mobile Cockpit displays a message notifying you when to
replace the battery pack.
Look at battery life under battery control on the Mobile Cockpit. If the
signal is red, it is time to replace the battery pack with a new one.

Important The values that appear in the Battery Report are provided for
general reference only. Actual operability of the battery is affected
by operating environment and other conditions.

Tap here.
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When Two Battery Packs Are Mounted
When two battery packs are mounted, the hot-swapping function
allows either of the two battery packs to be replaced while the other is
in use even if FIVA is turned on.

About charging
Charging is started from the battery pack having more remaining
power. So, check the charging state by the color of the BATT1/BATT2
indicator lamps.
When the battery pack being charged becomes fully charged,
charging of the other battery pack is started.
If the battery pack standing by to be charged is replaced with a
battery pack that has more remaining power than the battery pack
being charged, the battery pack to be charged will not be changed.

When Replacing Two Battery Packs
Connect the AC adapter when replacing two battery packs at the
same time.
Also, prepare two charged battery packs, and wait until the first
replaced battery pack has been detected by the FIVA before
replacing the second battery pack.
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Chapter 3
Supplementary
Information
This chapter contains information
about how to connect
peripherals and what to do
when you experience
problems.
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Note the following important points before connecting a peripheral.
• Some peripherals require changes in FIVA settings.

Some peripherals require certain settings to be made before they
can be used.

• Use only special cables for connections.
Use only the specified cables to connect peripherals. Even if the shape
of a connector on a cable appears the same as that for the specified
cable, it may not work properly. Carefully check to make sure you are
using the correct cables.

• Carefully read the documentation that comes with the peripheral.
The peripheral connections described in this user’s guide are general
examples. Actual connection methods and settings depend on the
peripheral. When connecting a peripheral, use the procedures
provided in this user’s guide in combination with the documentation
that comes with the peripheral.

Connecting a Peripheral to FIVA

A “peripheral” is a device, like a printer or external floppy disk drive that
you connect to FIVA. The following procedure describes how to connect
a peripheral to FIVA and how to install a PC card or expansion memory.
For the peripherals that are not described in this User’s Guide, see the
manual that comes with the penipheral you are installing.

Important Be sure to turn off the power of FIVA and unplug the power cord
before connecting peripherals. Even for the peripherals that are
compatible with the plug and play function, it is better to turn off the
power before connection.
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Connecting a Headphone or a Microphone
By connecting commercially available headphone or microphone to this
unit, the sound function built in this unit can be used.

To connect the headphone
Connect the headphone plug to the headphone port ( ) on the right of
this unit. For details of the volume adjustment, see “u Adjusting the
volume” on page 131.
Use a headphone which has the stereo mini jack (ø3.5 mm).

Connect the headphone plug to the headphone port ( ).
To disconnect the plug, pull it out from the port by holding the plug.

Important Do not use the headphone on the following occasions. Noise may be
heard.
• When turning on/off the power of this unit.
• When connecting/disconnecting the headphone.
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To connect microphone
Connect the microphone plug to the microphone port ( ) on the right of
this unit.
Use a microphone which has the monaural mini jack (ø3.5 mm).

Connect the microphone plug to the microphone port ( ).
To disconnect the plug, pull it out from the port by holding the plug.

Connecting to the LAN port
By using the LAN port, you can connect to the standard Ethernet
(10Base-T/100Base-TX). An Ethernet cable is necessary when
connecting to the Ethernet. After connecting, setting the software is
necessary in order to connect to the network using the TCP/IP function.

1. Connect one end of the Ethernet cable to the LAN port on the left
side of the unit and the other end to the network.

Ethernet cable

Important Only an Ethernet cable can be connected to the LAN port. Other
cables cannot be connected.
Connecting other cables (e.g. modular cable for telephone use) by
mistake to the LAN port may break the LAN port connector or cause
malfunction.

2. After connecting, perform the setting of the software to use the
Ethernet.
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Connecting to the modem port
The built-in 56kbps modem provides a high-speed data communication
and facsimile transmission/reception capabilities. (The actual
communication speed depends on the local line conditions, etc.) You
can use this function by connecting the modular cable to the modem
port.

The built-in modem can be connected to the general telephone line
(analog). It cannot be connected directly to the digital line (the ISDN
circuit, etc.). Also, it cannot be connected to the line for a home telephone
or office telephone which uses the telephone switchboard. When
connecting to the ISDN circuit, the optional terminal adapter (TA), dial-
up router, etc. is also necessary. After connecting, setting the software
is necessary in order to perform the connection for communication via
the telephone or facsimile line.

Modular cable

1. Confirm that the power of this unit is turned off.
Connecting or disconnecting the modular cable should be performed
after turning off the power.

2. Open the lid of the modem port ( ) and insert one end of the modular
cable securely until it clicks.

Important • Do not transport the unit when the modular cable is connected to
the modem port. It causes a damage of the modem port or the
disconnection of the modular cable.

• When you make a dial-up connection to the pulse system telephone
line using the built-in modem, it may malfunction and call up a wrong
phone number unintentionally and fail to connect to the correct phone
number. To avoid this, do not start up an application that causes
frequent accesses to the hard disk. Also, do not connect the
peripherals or access them before completing the dial-up
connection.
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Performing Infrared Communications
A communications function compliant with the IrDA infrared
communications system is provided on the rear of FIVA. Infrared
communications allows you to send and receive data to and from another
computer.

Infrared communications port

Locate FIVA and the other device supporting the IrDA interface so that
they directly face each other.

Wireless link icon

The wireless link ( ) icon is displayed on the desktop and in the
indicator area.
Double-click this icon.

Select the name of the file to send, and click the [Send] button. This
starts data transmission.
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Connecting to the USB port 
The USB (Universal Serial Bus) is a standard interface specification for
the connections of the USB compatible peripherals such as a keyboard,
mouse, printer, scanner, etc. to the computer.

Connecting to or disconnecting from the USB port can be performed
even when the power of this unit is turned on.
(Right side: USB1.1, Left side: USB2.0)
Insert the plug of the USB cable to the USB port securely with the plug’s
mark ( ) facing upwards.

Important • When this unit enters the Suspend Mode such as the Hibernation or
Standby Mode while USB devices are connected, the USB devices
may not be used after the unit is restored from the Suspend Mode.
In this case, re-connect the USB devices or restart this unit.

• The compatible system (OS) and the driver is required for using
USB devices.

• The performance of any USB compatible device connected to this
unit must be checked thoroughly by the user.

Note
• If one USB port on this unit is not enough, use commercially available

USB hub. USB hub with power-supply capability is recommended.
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Connect the MPC-240FDD
to the USB port of this unit.

Using the floppy disk drive
The optional USB compatible floppy disk drive (MPC-240FDD) is
available for this unit. The two types of floppy disk can be used with this
unit. One is 2DD floppy disk with the capacity of 720 KB and the other
is 2HD floppy disk with the capacity of 1.44 MB. (For details, see the
manual that comes with the floppy disk drive.)
Connecting the floppy disk drive allows you to store data and to copy
data to other computer.

The access lamp on the floppy disk drive lights while data is being
written to or recalled from a disk. Never remove the floppy disk from the
drive while the access lamp is lit. Doing so may cause malfunction of
the floppy disk drive or corruption of data.

Note
• When using the floppy disk that is not formatted for the Windows,

formatting is required. However, the disk cannot be formatted to the
disk with the capacity of 1.2 MB.

• Once the disk is formatted, all data stored in the floppy disk is erased.
Be careful when formatting the disk.

• The floppy disk that is formatted on other computer may not be
used.

• The 2HD floppy disk that is formatted in the 2DD type cannot be
used, and vice versa. Use a floppy disk that is formatted correctly.

To write protect a floppy disk
Floppy disks have a write protect tab that you can use to protect the
data on them from accidental deletion or change.

Write protect tab

Data can be written to
the disk.

Data cannot be written to
or deleted from the disk.
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Connecting a Printer
A USB compatible printer can be connected to the USB port of this unit.

Installing the printer driver is required for using the printer. The printer
driver that comes with this unit or one (stored in a CD, floppy disk, etc.)
that comes with the printer can be used.
When a printer compatible with the plug and play function is connected
for the first time, the Add Printer Wizard screen appears. Follow the
procedure displayed on the screen to use the printer.
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Using External Monitor
Connect an external monitor to FIVA so that the operation can be
performed while viewing the big-screen.

To connect a Monitor

1. Turn off the power of FIVA after closing an application, etc.
Making sure that the RGB cable from the external monitor is oriented
correctly, connect the RGB cable to the RGB port of the FIVA.
Connect the power cord of the monitor to other power outlet. (For
details, see the manual that comes with the monitor.)

2. Turn on the power of the external monitor.
After that, turn on the power of FIVA and starts up Windows.

3. Press Fn + “0” to switch to the external monitor.
Each time Fn + “0” is pressed, the monitor function changes in the
following order: LCD → External monitor→ LCD and External monitor
→ LCD.

Important • The display screen momentarily goes blank when you change from
one monitor function to another. This is not malfunction.
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Changing the screen's resolution and colors
You can specify the resolution and number of colors only when using
an external monitor. Right click on the Windows Me desktop and select
Properties on the menu. The Display Properties appears.

Click the Setting tab and then make the Colors and Screen area settings
you want.

The following table shows the setting combinations that can be made for
Colors and Screen area.  The screen may not be always displayed in all
resolutions and numbers of colors depending on the external monitor.

Important The area of the screen on the FIVA that can be used as a touch panel
is only 800 × 600 pixels.

Colors Size (Pixels)

16-bit/256 640×480/800×600/1024×768/1280×1024/1600×600

24-bit 640×480/800×600/1024×768/1280×1024

These settings can
be changed.
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Using a PC Card

Using a PC Card
FIVA has one PC Card Standard PCMCIA TYPE II PC card slot (including
card compatible with the Card BUS).
You can use a PC card to connect various peripherals such as the CD-
ROM drive or DVD-ROM, etc. Almost of all PC cards can be inserted or
removed while the power of the unit is turned on. For the detail of using
the PC card, see the manual that comes with the PC card.

Important • Long term use of PC card that generates a lot of heat can cause
unstable card operation and malfunction and also can create the
danger of burns.

• Never insert or remove a PC card while an application is running.
• Never insert or remove a PC card while the unit is in the Suspend

Mode such as the Hibernation Mode or Standby Mode. Doing so
may cause data to be erased.

• If you set the unit to the Suspend Mode or Hibernation Mode while
a device connected to the PC card is in use, the unit may lock up
when recovering. To protect data from being erased or the unit from
unexpectedly malfunctioning, you are recommended to select the
Close all applications before entering Standby or Hibernation
setting.

• When using a PC card that is not compatible with the hot insertion
function, insert or remove the PC card after turning off the power of
the unit.
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Inserting a PC card
Make sure that the PC card is oriented correctly when you insert it into
the PC card slot. Inserting the PC card into the slot upside down forcibly
may damage the cable or the slot.

1. Connect the cable to the PC card. And, push the eject button into the
slot.

2. Making sure that the PC card is oriented correctly, insert the PC card
into the PC card slot.
Though you may be aware of some resistance while inserting the
PC card, push the card carefully and horizontally until it goes to the
end.

Push in the eject button.

When you use the PC card for the first time, Windows automatically
detects it and installs the appropriate software for it.

If the PC card is not detected, the screen for adding new hardware is
displayed. Follow the instructions displayed in this screen.
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Removing a PC card
Before removing a PC card from the slot, first click the Mobile Cockpit
PC Card button ( ) and disable PC card operation and then remove
the PC card. Also, make sure that an application or system is not running.
The PC card can be inserted or removed even when the power of this
unit is turned on or off, but not when the unit is in the Suspend Mode.

1. Stop using the PC card.
Click the Mobile Cockpit PC Card button ( ) or double-click the
PC Card button ( ) on the indicator area to open PC Card
(PCMCIA) Properties. Select the card name from the list, and then
click Stop to cut off the power to the PC card.

When “You may safely remove this device.” appears, click OK.

2. Press the PC card eject button.
When the PC card is ejected, pull it out the rest of the way by hand.

Push the eject button.

Select the card here.

• When removing the PC
card, do not pull the
cable of the PC card.
Doing so causes
malfunction arisen from
the disconnection, etc.

• When the eject button is
pushed into the slot,
press the head of the
button again.

Click the Stop button.
➔
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Using a CF Card

Using a CF Card
FIVA has one CF TYPE I/II CF (Compact Flash) card slot. You can use a
CF card to load the expansion memory or hard disk. Almost all CF cards
can be inserted or removed while the power of the unit is turned on. For
the detail of using a CF card, see the manual that comes with the CF
card.

Important • Long term use of CF card that generates a lot of heat can cause
unstable card operation and malfunction and also can create the
danger of burns.

• Never insert or remove a CF card while an application is running.
• Never insert or remove a CF card while the unit is in the Suspend

Mode such as the Hibernation Mode or Standby Mode. Doing so
may cause data to be erased.

• If you set the unit to the Suspend Mode or Hibernation Mode while
a device connected to the CF card is in use, the unit may lock up
when recovering. To protect data from being erased or the unit from
unexpectedly malfunctioning, you are recommended to select the
Close all applications before entering Standby or Hibernation
setting.

• When using a CF card that is not compatible with the hot insertion
function, insert or remove the CF card after turning off the power of
the unit.
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Inserting a CF card
Make sure that CF card is oriented correctly when you insert it into the
CF card slot. Inserting the CF card into the slot upside down forcibly
may damage the connector or the slot.

1. Push the eject button into the slot.

2. Making sure that the CF card is oriented correctly, insert the CF card
into the CF card slot.
Though you may be aware of some resistance while inserting the
CF card, push the card carefully and horizontally until it goes to the
last.

When you use the CF card for the first time, Windows automatically
detects it and installs the appropriate software for it.

If the CF card is not detected, the screen for adding new hardware is
displayed. Follow the instructions displayed in this screen.

Push in the
eject button
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Removing a CF card
Before removing a CF card from the slot, first click the Mobile Cockpit
PC Card button ( ) and disable CF card operation and then remove
the CF card. And, be sure that an application or system is not running.
The CF card can be inserted or removed even when the power of this
unit is turned on or off, but not when the unit is in the Suspend Mode.

1. Stop using the CF card.
Click the Mobile Cockpit PC Card button ( ) or double-click the
PC Card button ( ) on the indicator area to open PC Card
Properties. Select the card name from the list, and then click Stop to
cut off the power to the CF card.

When “You may safely remove this device.” appears, click OK.

2. Press the CF card eject button.
When the CF card is ejected, pull it out the rest of the way by hand.

• When the eject button is pushed into the slot, press the head of the button
again.

Click the Stop button.

Select the card here.

Push the eject button.

➔
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Loading an Expansion Memory

You can expand the FIVA memory by installing an expansion memory
board. Expanded memory can help applications and large-volume data
to be operated at a high speed. Use the optional expansion memory
board (MPC-252RAM/253RAM/754RAM) or one specified by CASIO.

Before installing or removing expansion memory board

Do not disassemble the unit except the part described below.
As the high-voltage components are inside FIVA, improper
usage causes damage to the unit.

Do not place containers of liquids near FIVA and do not allow
any foreign matter to get into it. Doing so creates the danger
of shorting, fire and electric shock. If water or other foreign
matter gets into FIVA, Do not turn on the power and contact
your original retailer or authorized distributor.

Important • The interior of FIVA can become quite hot during normal use. In this
case, leave the unit for about 10 minutes to allow the interior of the
unit to be cool before installing or removing the expansion memory.

• Shut down the power, unplug the AC adapter and remove the battery
pack before installing or removing the expansion memory.

• As the expansion memory is the precision electronic product, it may
be damaged by static electricity from your body. Be sure to touch a
metalic object to discharge any static electricity from your body
before installing the expansion memory.

Installing the expansion memory board
1. Quit all applications and shut down the power.

When the unit is in the Suspend Mode (Hibernation Mode or Standby
Mode), restore the system and shut it down.

2. Disconnect the AC adapter, power cord and all peripheral cables
from FIVA. Then turn over the FIVA and remove the battery packs.
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3. Remove the screw from the memory replacement cover near the
center of the top section of the turned over FIVA.

4. Lift up the cover to remove.
5. When the cover is removed, the expansion memory slot appears.

Align the notched sections (q) of the expansion memory board with
the protrusions (w) of the expansion memory slot, and insert the
expansion memory board diagonally while paying attention to its
orientation and insertion angle until its terminals come into contact
with the inside of the slot (e) .
Push in from above until the expansion memory board clicks in
place (r).

w

r

e

q

6. Repeat the above procedure in reverse.
Fit in the memory replacement cover, and fix with the screw.
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Removing the expansion memory board
Perform steps 1 to 4 of the procedure of “Installing the expansion memory
board.”

5. When the memory replacement cover is removed, the expansion
memory slot appears.
Pull up the inserted memory board while prizing apart (q) both sides
of the expansion memory slot to the left and right, and remove the
inserted memory board. (w) When removing the memory board,
take care not to excessively press or bend it.

w

q

q

6. Fit in the memory replacement cover, and fix with the screw.

Checking the capacity of the expansion memory
Be sure to check that the expansion memory board is installed correctly
and FIVA detects the expansion memory you installed. If the capacity
of the expansion memory does not increase, the following problems
are assumed:
• The memory board is not installed correctly, or
• The memory board is not a specified one by CASIO.

To check the capacity of the RAM (The amount subtracted 16 from the
system memory.), click Start → Settings → Control Panel → System
→ System Properties → General. 16 is the capacity of RAM for using
the system.
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Using the “Mobile Cockpit #”

The CASIO original application software “Mobile Cockpit3” is installed
in this unit. The “Mobile Cockpit3” is always displayed as a tool bar on
the desk top of the Windows and it allows you to perform the convenient
settings easily. When the “Mobile Cockpit3” is not displayed on the
screen, click  in the indicator area to start up.
* After this, “Mobile Cockpit3” is described as the mobile cockpit.

Description

Switches the display between the “Control
bar” and the “Launcher bar”

Changes the arrangement of the tool bar
or hides the display.

Specifies the “One Touch Operation
Buttons”, “Wake On Timer Setting”, “Power
Management Setting” or “Settings
(Preferences)”.

Set to each of the “Full power”, “Normal”,
“Economy” or “User”.

Adjusts the brightness of display.

Setting LAN use at multiple locations
enables the LAN to be used easily at
different locations.
Adjusts sound level from the speaker

Specifies the settings to use the PC or CF
card.

Changes the speed of CPU.

Set the warning for a low battery or
displays the information about a battery.

Displays the remaining power, installation
state, etc.
Set this unit to the Standby Mode.

Set this unit to the Hibernation Mode.
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q  Switching the tool bar
The Mobile Cockpit has the Control bar and Launcher bar. You can
switch the display between them depending on your usage. When you
click  or , the display is switched between the Control bar and
the Launcher bar.
• Control bar

It allows you to specify each setting easily. When you click the
appropriate button, the window appears. So, you can follow the
procedure displayed in the window.

• Launcher bar
By registering the applications (up to 19 applications) in the tool bar,
the applications start up when you click the button. It is convenient
that you register the applications you often use.

Registering applications in the “Launcher bar”

To register applications you use from the Start menu.

1. Click Start in the Windows, select application from Program you
want to register and then drag and drop it in the Launcher bar.

Drag and drop the application you want to register in the tool bar.
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2. Confirm that the button of the application you registered is displayed
in the Launcher bar.

To register applications from the “My Computer”.

1. Drag and drop application you want to register from the My Computer
in the Windows to the Launcher bar.

2. Confirm that the button of the application you registered is displayed
in the Launcher bar.

To start up the application you registered

1. Clicking the Switching the tool bar button in the Mobile Cockpit to
switch to the Launcher bar from the Control bar.

2. Click the button of the application you want to start up.

3. The application starts up.
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To delete the application you registered
1. Clicking the Switching the tool bar button in the Mobile Cockpit to

switch to the Launcher bar from the Control bar.

2. Right-click the button of the application you want to delete.

3. Click the Delete in the menu.
When you click the All Delete, all the applications you registered
are deleted.

4. Confirm that the button of the application you deleted is not displayed
in the “Launcher bar”. (The button of the application is only not
displayed. The application itself is not deleted.)

To move the application you registered

1. Clicking the Switching the tool bar button in the Mobile Cockpit to
switch to the Launcher bar from the Control bar.

2. Right-click the button of the application you want to move.

3. Click the Move in the menu.
When it is clicked, the frame appears around the icon of application.

4. Right-click the button of the application you want to move and then
drag to the desired position in the Launcher bar.

Right-click the icon of the application.
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w  Panel

Changing the display position of the tool bar
By dragging the panel, the “Mobile Cockpit” can be displayed in the
following 5 positions of the desk top screen.

Although the tool bar and the
Windows taskbar are displayed
together, the Windows taskbar has
priority over the tool bar. When the
tool bar of the Mobile Cockpit is
displayed on the left or right side
of the screen, a short tool bar (as
shown on right) is displayed.

The upper part of the screen The lower part of the screen

The right side of the screen The left side of the screen

Floating
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Pop-up menu
When you right-click this part, the pop-up menu is displayed.

Auto hide
When the check mark is put in the Auto hide, the tool bar is hidden. In
this setting, when you move the pointer to each corner of the screen,
the tool bar appears and when you move the pointer aside from the
corner of the screen, the tool bar is hidden. When the check mark is not
put, the tool bar is always displayed.

Always on top
The tool bar in the Mobile Cockpit is always displayed in front. This
setting allows you to display the tool bar in front even when other windows
are displayed.

Sound Effect
The effective sound can be heard when you click each button of the
Mobile Cockpit. This lets you know that inputting is performed.

Use LAN connection switch
Clicking this item enables use of LAN connection switching.

Important • When you use Windows or Mobile Cockpit III task bar at left or right
side of the screen, do not set Auto hide active.

• If you place the task bar at left or right side on the screen and set
Auto hide active, the icons on the task bar may be hidden which
makes you find the icons difficult.

• This precaution should be ignored if you operate the screen with a
mouse.
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Help
When you need the information about the Mobile Cockpit, this lets you
know how to operate.

Version info
This displays the version information of the Mobile Cockpit.

Exit
This closes the application of the “Mobile Cockpit3”. When you want
to use the tool bar of the “Mobile Cockpit3” again after closing it, you
need to start up from the “FIVA tool”.
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e  Settings
You can specify 4 settings of the “One Touch Operation Buttons”, the
Wake On Timer, Power Management and Settings.

One Touch Operation Button Setting
Three one touch operation buttons ( , P0, P1) are located on the
keyboard. Pressing each of these buttons starts up the application pre-
registered to that button. You can register the desired application to
each of the one touch operation buttons.

You can display a list of Windows standard files by pressing the
Reference button, and select the desired application and then register
it to each of the one touch operation buttons. If you do not register an
application to the buttons, leave the textbox vacant. In this case, the
applications do not start up even if you press the button.
The registered default for “ ” is “touch panel calibration”, for “P0”
“battery status display”, and for “P1” “screen inverted display software”.

Wake On Timer Setting
You can specify the way to restore from the Sleep Mode by putting the
check mark  in the check box.

In the Suspend Mode (the Standby Mode or the Hibernation Mode),
this unit can be restored from the mode when the day and time you set
comes.
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Power Management Setting
This allows you to prolong the using time of the battery pack when you
change the settings of the Suspend Mode, CPU, hard disk and the LCD
monitor and the power supply according to the conditions. (This function
is called “Power Management”.)
To make the change of the using condition easier, the three modes of
“FULL POWER”, “NORMAL” and “ECONOMY” are provided. And, for
the power, the two modes of “USER AC” and “USER DC” are provided.
The three modes and the two modes can be specified respectively. The
following items can be specified. In this window, the power management
setting for the system and the devices can be specified by selecting
“USER AC” or “USER DC”, and the setting for this unit can be specified
by selecting “FULL POWER”, “NORMAL” or “ECONOMY”.
• The time until this unit enters the Suspend Mode after the unit is not

used.
• The speed of CPU (Long-Run setting)
• The time until the function of hard disk stops after the unit is not used.
• The brightness of the display
• The time until nothing is displayed in the LCD monitor after the unit is

not used.

Important You can also specify the power management setting of this unit by
selecting “Control panel” → “Power Options” → “Power Options
Properties”.

Normally, you should specify only the setting of the “Power
Management Setting” in the Mobile Cockpit because it is easier to
operate.
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FULL POWER

NORMAL

ECONOMY
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USER AC
This setting is when the power is supplied to this unit by the AC adapter.

USER DC
This setting is when the power is supplied to this unit by the battery
packs.
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Settings (Preferences)
The initial setting can be set to use this unit. The two settings of “Built-in
LAN on/off”, “Power Switch Action” can be specified.
When the restart is necessary after the setting is changed, the display
to restart this unit appears after you press the OK button.

Built-in LAN
When you do not use the built-in LAN, remove the check mark  from
the check box .

When the built-in LAN settings have been changed, a message
prompting you to reboot the computer is displayed.

Power Switch Action
If the power switch is pressed while FIVA is being used, one of [Standby],
[Hibernation] and [Power Off] can be set.
To restore FIVA from a suspend mode, lightly touch the power switch
momentarily.
If the power switch is held down continuously, power is forcibly turned
OFF.
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When the button is depressed.

Full power Normal Economy User

r  Power management

When you press one of the “Full power”, the “Normal”, the “Economy”
and the “User” button to select the setting of the “Power Management
Setting” described before, the setting of the power management for
this unit can be specified.
The selected button is depressed. (The “Full power” button is selected
in the illustration shown above.)
The power condition is shown in the indicator of the selected button
when you switch to the AC adapter or to the battery pack.

• When the AC adapter is used, the indicator on the upper left of the
button is turned on or off according to the operation you click the
icon.

• When the battery pack is used, the indicator on the lower right of the
button is turned on or off according to the operation you click the
icon.

t  Brightness control
You can adjust the brightness of
LCD monitor.
Adjust the brightness of LCD
monitor by dragging the control
bar. After adjusting it, click the
“Save the user mode” to save the
items of the “LCD monitor
setting” in the “Setting of power management” described before. If you
do not save the setting, the LCD monitor is displayed in the brightness
previously set in the “LCD monitor setting” of the “Setting of power
management” when you restart the unit.
• Also, you can adjust the brightness of LCD monitor using the hot key

combinations such as “ Fn  + “1” ( )” or “ Fn + “2” ( )”.
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y  LAN connection switch
Up to 16 LAN settings can be set to FIVA, each with individual names
for each of the different locations.
With these individual LAN settings, you set the name of your own
computer, IP address, proxy setting, and the normally used printer.
If LAN settings are already set when the LAN connection switch button
is pressed, the following dialog box is displayed.

To add new LAN settings, click New , and to correct existing LAN
settings, click Edit . This enables any LAN to be used at any location.

u  Adjusting the volume
You can adjust the volume for the speaker. Adjust
the volume by dragging the control bar. When you
put the check mark  in the check box of the
“mute”, the sound is muted.

• Also, you can adjust the volume using the hot
key combinations such as “ Fn  + “5” ( )” or
“ Fn  + “6” ( )”.
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i  PC card properties
 The( ) button open Windows PC card (PCMCIA) properties.

 ( ) button
To remove the PC card by operating from this screen.

All currently connected storage devices including PC cards can be
removed by the [Eject Hardware] button ( ) in the indicator area.
(page 111)

o  Long-Run setting
By setting the function range of CPU of this unit, you can decrease the
power consumption and prolong the using time of the battery packs.
The CPU functions within the upper value and the lower value.

Click  to display the upper value and lower value you specified.
When you click the displayed value, the display is switched between
the CPU speed and the voltage.

Note
The shape of the indicator area ( ) icon changes when the CPU
operating speed is changed.
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!0  Battery Control
This window displays the condition of the battery packs. You can check
the connecting condition of the battery packs, the remaining power of
the battery packs or the time to replace with a new battery pack, etc.

The reading of the Rated capacity does not guarantee the actual
capacity of the battery packs which are being used. Therefore the
capacity of the full-charged battery pack and the Rated capacity do
not coincide with each other.

When you click the battery control button while power is supplied from
the AC adapter, the “On AC power” screen shown below appears.
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!1  Battery indicator
The battery indicator indicates the battery pack remaining power and
installed state at all times.
When running FIVA by the battery pack only
• The display differs when only battery pack is installed and when two battery

packs are used.
For one battery pack For two battery packs

       

When two battery packs are installed
• The average value of the total battery power is displayed as the

remaining power. However, the level indicator shows each of their
battery powers.

• The order of battery pack use will not change even if the battery pack
is replaced with one having more remaining power.
As the battery pack currently in use wears down and the remaining
power of the two battery packs become the same, both wear down at
the same rate.

When using the AC adapter and battery pack
• If the AC adapter is connected, the battery packs will be charged all

the time. Regarding the order of priority in charging the battery packs,
charging will start with the battery pack having the larger amount of
remaining power. This order will not change even if one of the battery
packs is replaced during charging.

       

When running FIVA by the AC adapter only
• This is displayed when the battery pack is not installed.

CALCULATE
• “CALCULATE” appears right after the battery pack is installed. If this

message remains to be displayed, install the battery pack once again,
or the replacement with a new battery pack is required because of
the exhaustion of the battery pack.

Remaining power compensation in progress
• This is displayed when processing for improving accuracy in

measurement of the battery pack remaining power is being carried out.
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!2  Standby Mode
When you click the standby button ( ), this unit enters the Standby
Mode.
• You can also set to the Standby Mode by pressing “ Fn  +  “3”  ( )”,

selecting “Standby” after selecting the “Shut down”, or performing
the operation of “e Settings” described before. If you click this button
when the wake on timer setting is set to on, the unit is restored from
the Standby Mode when the time you set comes.

!3  Hibernation Mode
When you click the hibernation button ( ), this unit enters the
Hibernation Mode.
• You can also set to the Hibernation Mode by pressing “ Fn  + “4”

( )”, selecting “Hibernation” after selecting the “Shut down”, or
performing the operation of “e Settings” described before. If you
click this button when the wake on timer setting is set to on, the unit is
restored from the Hibernation Mode when the time you set comes.
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The following explanation on pages 136 to 143 is about the Terminal
Equipment embedded in CASSIOPEIA FIVA series and described by
following the rules. The Terminal Equipment is operable and compliant
with the regulations in the United States and Canada only.
For users of CASSIOPEIA FIVA series resident in other countries, the
description and the instruction of the equipment are not applicable.

Using the Terminal Equipment 1456VQL19V (INT) (built-in Modem)

IMPORTANT SAFETY INSTRUCTIONS
When using the FIVA (with the modem integrated), basic safety
precautions should always be followed to reduce the risk of fire, electric
shock and injury to persons, including the following:

1. Do not use the FIVA near water, for example, near a bathtub, washing
bowl, kitchen sink or laundry tub, in a wet basement or near a
swimming pool.

2. Avoid using the FIVA while a modular cable from telephone-output
connected to the MODEM port during an electrical storm. There may
be a remote risk of electric shock from lightning.

3. Do not use the FIVA connected to a telephone-output to report a gas
leak in the vicinity of the leak.

4. Use only the power cord, the AC adapter and the batteries specified
in this manual. Do not dispose of batteries in a fire. They may explode.
Check with local codes for possible special disposal instructions.

CAUTION: TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26AWGOR
LARGE TELECOMMUNICATION LINE CORD.

For users in the United States
This equipment complies with Part 68 of the FCC rules. On the back
side of this equipment is a label that contains, among other information,
the FCC registration number and ringer equivalence number (REN) for
this equipment. If requested, this information must be provided to the
telephone company.

USOC Jack,RJ11C is available to this equipment.

An FCC compliant telephone cord and modular plug is provided with
this equipment. This equipment is designed to be connected to the
telephone network or premises wiring using a compatible modular jack
which is Part 68 compliant. See Installation Instructions for details.
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The REN is used to determine the quantity of devices which may be
connected to the telephone line. Excessive RENs on the telephone line
may result in the devices not ringing in response to an incoming call. In
most, but not all areas, the sum of RENs should not exceed five (5.0). To
be certain of the number of devices that may be connected to a line, as
determined by the total RENs, contact the local telephone company.

If the terminal equipment 1456VQL19V (INT) causes harm to the
telephone network, the telephone company will notify you in advance
that temporary discontinuance of service may be required. But if advance
notice isn’t practical, the telephone company will notify the customer as
soon as possible. Also, you will be advised of your right to file a complaint
with the FCC if you believe it is necessary.

The telephone company may make changes in it’s facilities, equipment,
operations or procedures that could affect the operation of the
equipment. If this happens the telephone company will provide advance
notice in order for you to make necessary modifications to maintain
uninterrupted service.

If trouble is experienced with this equipment 1456VQL19V (INT), for
repair or warranty information, please contact CASIO INC.
(973.361.5400). If the equipment is causing harm to the telephone
network, the telephone company may request that you disconnect the
equipment until the problem is resolved.

This equipment cannot be used on public coin phone service provided
by telephone company. Connection to party line service is subject to
state tariffs. (Contact the state public utility commission, public service
commission or corporation commission for information.)

The Telephone Consumer Protection Act of 1991 makes it unlawful for
any person to use a computer or other electric device, including fax
machines, to send any message unless such message clearly contains
in a margin at the top or bottom of each transmitted page or on the first
page of the transmission, the date and time it is sent and an identification
of the business or other entity, or other individual sending the message
and the telephone number of the sending machine or such business,
other entity, or individual.

In order to program this information into your fax machine, you should
see your FAX application software manual.

 MPC701M50E#p136~143 02.11.22, 10:17 AM137



138

According to the FCC’s electrical safety advisory, we recommend that
you may install an AC surge arrestor in the AC outlet to which this
equipment is connected. Telephone companies report that electrical
surges, typically lightning transients, are very destructive to customer
terminal equipment connected to AC power source and that this is a
major nationwide problem.

This equipment is registered with the FCC under Part 68 as a component
device for use with CASIO COMPUTER CO., LTD. models CASSIOPEIA
FIVA Series. In order for the FCC registration of this product to be
retained, all other products used in conjunction with this product must
also be FCC Part 68 registered for use with this host. If any of these
components are not registered, then you are required to obtain FCC
Part 68 registration of the assembles equipment prior to connection to
the telephone network. Part 68 registration requires that you maintain
this approval and as such are responsible for the following:

Any component added to your equipment, whether is bears
component registration or not, will require a Part 68 compliance
evaluation. You may need to test and make a modification filing to
the FCC before that new component can be used;

Any modification/update made by a manufacturer to any registered
component within your equipment, will require a Part 86 compliance
evaluation. You may need to test and make a modification filing to
the FCC before that modified component can be used;

If you continue to produce this component you are required to comply
with the FCC’s Continuing Compliance requirements.

Therefore is all recommended that only FCC Part 68 registered
devices bearing the ‘CN’ or ‘CE’ equipment code as part of FCC
registration number, be used. To determine if your particular
component is appropriately approved, look for the FCC registration
number on all components and ensure that the classification code
‘-CN-’ or ‘-CE-’ is part of that number. Refer to the FCC Registration
number on this products as an example.”

If the telephone company requests that you supply the FCC Registration
number and REN of the device you are connecting, please supply the
FCC Registration numbers from all component and host devices that
have a direct PSTN connection (i.e. have an REN stated on the label)
and the highest REN.
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Notice Concerning FCC Radial Regulations
Note that federal law prohibits you from using software that is not in
compliance with FCC rules that regulate redialing on the computer or
other device where this modem is installed.

For users in Canada
NOTICE:  The Industry Canada label identifies certified equipment. This
certification means that the equipment meets telecommunications
network protective, operational and safety requirements as prescribed
in the appropriate Terminal Equipment Technical Requirements
document(s). The Department dose not guarantee the equipment will
operate to the user’s satisfaction.

Before installing this equipment, users should ensure that it is permissible
to be connected to the facilities of the local telecommunications
company. The equipment must also be installed using an acceptable
method of connection. The customer should be aware that compliance
with the above conditions may not prevent degradation of service in
some situations.

Repairs to certified equipment should be coordinated by a representative
designated by the supplier. Any repairs or alterations made by the user
to this equipment, or equipment malfunctions, may give the
telecommunications company cause to request the user to disconnect
the equipment.

Users should ensure for their own protection that the electrical ground
connections of the power utility, telephone lines and internal metalic
water pipe system, if present, are connected together. This precaution
may be particularly important in rural areas.
Caution: Users should not attempt to make such connections
themselves, but should contact the appropriate electric inspection
authority, or electrician, as appropriate.”

NOTICE: The Ringer Equivalence Number (REN) assigned to each
terminal device provides an indication of the maximum number of
terminals allowed to be connected to a telephone interface. The
Termination on an interface may consist of any combination of devices
subject only to the requirement that the sum of the Ringer Equivalence
Numbers of all the devices does not exceed 5.”

The Ringer Equivalence Number of This terminal equipment is 0.3.
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For users in Europe
The modem integrated in this product has been approved in accordance
with Council Decision 98/482/EC for Pan-European single terminal
connection to the Public Switched Telephone Network (PSTN).
However, due to differences between the individual PSTNs provided in
different countries in Europe, the approval does not, of itself, give an
unconditional assurance of successful operation on every PSTN network
termination point.

In the event of problem, you are advised to contact your local dealer or
CASIO distributor in the first instance.

Network compatibility
The modem has been designed for the use with the following networks
and tested in compliance with EG 201 121 standard.

Germany ATAAB AN005, 006, 007, 009, 010, 016 and
DE03, 04, 05, 08, 09, 12, 14, 17

Greece ATAAB AN005, 006 and GR01, 03, 04

Portugal ATAAB AN001, 005, 006, 007, 011 and P03, 08

Spain ATAAB AN005, 007 and ES01

Switzerland ATAAB AN002

Norway ATAAB AN002, 005, 007 and NO01, 02

All other European ATAAB AN002, 003, 004
countries/areas

For each network different settings and configurations of the software
are necessary.
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Function Protocol Speed Comment

Network control functions Automatic Send and Receive by built-in NCU

Modem protocols
Conforms to the following protocols and possible to
communicate in full duplex V.21/V.22bis/V.32/V.32bis/V.34/
V34bis/V.90/K56flex/V.27ter/V.29/V.17

Data compression
protocols

Conforms to MNP 5, ITU-T V.42bis

Error control protocols Conforms to MNP 4, ITU-V.42

ITU-T V.21
ITU-T V22bis
ITU-T V32

ITU-T V32bis

ITU-T V34

V.90

K56flex

ITU-T V.27ter
ITU-T V.29

ITU-T V.17

300
2400, 1200
9600, 4800
14400, 12000, 9600,
7200, 4800
33600, 31200, 28800,
26400, 24000, 21600,
19200, 16800, 14400,
12000, 9600, 7200,
4800, 2400
56000, 54667, 53333,
52000, 50667, 49333,
48000, 46667, 45333,
42667, 41333, 40000,
38667, 37333, 36000,
34667, 33333, 32000,
30667, 29333, 28000
56000, 54000, 52000,
50000, 48000, 46000,
44000, 42000, 40000,
38000, 36000, 34000,
32000
4800, 2400
9600, 7200
14400, 12000, 9600,
7200

There are two modes,
Long and Short in each
speed respectively.

Data
communication
(Send and
Receive)

Data
communication
(Receive only)

FAX
communication

Main functions of the modem
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FIVA with embedded 1456VQL19V (INT)

Connecting to telephone line
The modular cable that comes with the modem shall be used to connect
the modem to the telephone line.
In this case, if the telephone line is available through the modular jack,
it is possible to connect the modem to the telephone line directly.
Otherwise, an adapter is required or modification of the telephone line
socket might be necessary.

Modem port
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Connector for communication
(for connection to the dedicated Modular cable)

Connecting to the FIVA
Turn off the power of the FIVA first and then connect as depicted below.

Caution on operation of the product
To use this product, operate as instructed below since this is designed
to be embedded in the FIVA.

1. The product must be set in a case upon use.
2. Do not leave the product in the area such as hot and humid or exposed

to direct sunlight since it is a precision product.
3. Do not spill any liquid such as water on the product.
4. Do not touch electronic terminals without discharging static fully

otherwise it will cause damage.
5. In case the product is used exceeding the maximum specification,

there is possibility that LSIs inside might be damaged permanently.
Therefore, it is favorable to use the product under the normal operation
conditions.  If the product is left above the normal operating conditions,
it might be possible to affect to the reliability of the LSIs.

Modular cable
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Troubleshooting

This section describes what you should do whenever you start to
experience problems with operation of FIVA, its peripherals, or
applications you are running.

Basic Troubleshooting

Note the following important points whenever you are
experiencing problems.
1. Take your time.

If the system seems to hang up, resist the urge to turn off power,
click things on the display, or press keyboard keys. The operation
you are performing may simply require a bit more time.

2. Take notes of information that appears on the display.
Message, numbers, and codes that appear on the display may
provide hints to the cause of the problem and what you need to
overcome it. Keep notes of such information when it appears on
the display.

3. Try to determine the possible cause of the problem.
If FIVA is the source of the problem, or is it being caused by a
peripheral or application? Does the same operation or condition
always cause the same problem?
Is there something distinctive about the problem?

4. Check the documentation and on-line help.
You may be able to find information that leads to the solution of
the problem in the documentation or on-line help of FIVA, its
peripherals, or your applications.
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System Outline
Have the following information handy whenever you request user
support.

Memo about your system

Other information about FIVA can be found by visiting the
CASSIOPEIA Website at: http://www.casio.co.jp/English/system/

Model

Unit ID Number (on the bottom panel)

Memory Capacity(MB)

FIVA Hard Disk Capacity (GB)

Hard Disk Free Space (MB)

Battery Pack (Used/No Used)

External Monitor

Printer

Peripherals PC (CF) Card

Other Peripherals

Software Windows Version

Remarks
All applications running

when problem occurred
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FIVA Malfunction
Symptom

FIVA is emitting smoke and heat.

FIVA malfunction

You don’t know what to do.

Recommended Action

Immediately turn off power, remove the
Battery Packs, and unplug the AC adapter
from the wall outlet.

Contact your original dealer or authorized
distributor. Have the following information on
hand.
• Product name and model number
• Date of purchase
• Current status and the names of

applications being used

Contact your authorized distributor. Have the
following information on hand.
• Product name and model number
• Date of purchase
• Current status and the names of

applications being used
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Power Supply

Note
For safety reasons, FIVA is designed so CPU Clock Speed slows down
whenever internal temperature rises above a certain level. If operation
continues, FIVA automatically the power turns off.

Symptom

Power does not turn on.
• Power indicator lamp is flashing red.
• Power turns on but immediately turns

off.
• Nothing happens when the power

switch is pressed.

Power turns on, but the system does not
start up.
• The system does not start up when

power is turned on in the Hibernation
Mode.

Power turns off.
• FIVA suddenly goes into the

Hibernation Mode and power turns off
while you are using it.

Battery pack does not supply much
operation time, even after a full charge.

Recommended Action

Use the AC adapter to power FIVA.
• Use a fully charged battery pack. If the

battery pack has small charge when
power is turned on, a warning message
appears momentarily and power turns
off.

Leaving power turned on, press the
RESET switch on the bottom of FIVA.
Note that the RESET operation will result
in loss of any data saved by the
Hibernation Mode.

Wait for a while to allow the interior of
FIVA to cool off. See the Note  at the
bottom of this page.

Use the AC adapter or a fully charged
battery pack to power FIVA. A low battery
pack can cause power to suddenly turn
off.

Open the Mobile Cockpit Battery Report
and check the battery inferior rate. When
the Battery LIFE mark becomes red, you
may need to replace the battery pack
with a new one.
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Display Problems

Password Problems

Symptom

Nothing on the display, Power indicator
lamp is not lit.

Display has gone blank.

Display contents are difficult to see.

Display is dim.

Recommended Action

Press the power switch to turn on power.

Touch anywhere on the display. FIVA’s
power saving function causes the display
to go blank if no operation is performed
for some time. See page 126.

Reorient FIVA so you can view the
display at a different angle.

Use Fn + “1” or Fn + “2” to adjust
display brightness. If the display remains
dim at a bright setting, it may mean that it
has reached the end of its service life.
With your FIVA model number on hand,
contact your original dealer or authorized
distributor.
Check if the backlight switch is on. (M30E)

Symptom

The operator forget the Windows
password.

The operator forget the password
registered in the BIOS settings.

Recommended Action

Restore the system to its factory defaults.

With your FIVA model number on hand,
contact your original dealer or authorized
distributor.
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Symptom

Cannot perform infrared data communi-
cation.

Cannot send data correctly using
infrared data communication.

Sound output is broken.

Audio skips during audio playback or
communication errors occur during
communication from the multi-
communication port.

Cannot hear speaker output.

Occasional inability to record from the
microphone or output sound from the
speaker.

Recommended Action

Make sure that the wireless link on the
control panel is enabled.
• Make sure there are no obstructions in

the infrared path between the two
devices.

Make sure the data transfer speed set for
FIVA is the same as that set on the other
device.
• Change the distance between FIVA and

the other device.
• Move the two devices to an area that is

not exposed to direct sunlight or
fluorescent lighting.

Tap the Mobile Cockpit CPU icon and
then use the slider to set the CPU Clock
Speed to [800MHz].
• Quit other applications before the

adjustment.

These conditions are caused by any of
the followings.
• Changing the power supply between

AC adapter power and battery pack
power

• Running the battery report
• Large load on the FIVA CPU
• Reduction of CPU clock speed due to

internal overheating

If a headphone is plugged into the FIVA,
unplug it.
• Change the volume control setting
• Remove the check when the setting of

“Volume control” is set to the “mute”

Change the volume control setting or re-start
FIVA.

Software Problems
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Symptom

Power indicator lamp flashes red
immediately after charging.

FIVA suddenly hangs up.

System runs too slow (1).

System runs too slow (2).

System runs too slow (3).

Displayed date and time are wrong.

Recommended Action

Purchase a new battery pack and replace
the current one. Battery packs tend to lose
their ability to charge after long use.

• If you suspect that the problem is due to
low battery power, connect the AC adapter
and charge the battery.

• If you suspect that the problem is being
caused by the application you are using,
press the RESET switch and restart
Windows.

• Try turning power off and then back on
again.

• Memory may be low, which means you
have to increase it by installing a
separately available DIMM board.

If Power Management is causing the system
to go into the Economy Mode, try changing
the Normal Mode or Full power Mode. See
page 126.

Turn power off and wait a while. Normal
operation should return after FIVA has a
chance to cool off.

• Use the Control Panel to set the correct
date and time.

• If the date and time seem to require
frequent setting, it may mean that the clock
battery is low. Contact your original dealer
or authorized distributor about having the
clock battery replaced.

General Operation Problems
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General Operation Problems (continued)

Symptom

Hot keys do not work.

Mobile Cockpit is not displayed.

Windows is hung up.

Recommended Action

Tap the Taskbar’s Start button and start up
Mobile Cockpit from the Programs menu.

• If Mobile Cockpit is not running, tap the
Taskbar’s Start button and start up Mobile
Cockpit from the Programs menu.

• If the Mobile Cockpit toolbar is hidden, tap
the Mobile Cockpit icon on the Taskbar
and then uncheck the Hide option on the
menu that appears.

• Press Ctrl + Alt + Del , and then tap
the Shut Down button. Next, restart
Windows.

• If Ctrl + Alt + Del  does not work,
press the RESET switch and then restart
the system.
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DECLARATION OF CONFIRMITY

We CASIO Europe GmbH
Bornbarch 10, D-22848 Norderstedt, Germany

declare under our sole responsibility that the product

Mobile Personal Computer, Models: MPC-701M50E, MPC-701M30E

to which this declaration relates is conformity with the following standards and
Council Directives;

Standards;
EMC: EN55022:1994+A1:1995+A2:1997

Limits and methods of measurement of radio disturbance
characteristics of information technology equipment
EN55024:1998
Information technology equipment - Immunity characteristics - Limits
and methods of measurement
EN61000-3-2:1995+A1:1998+A2:1998
EN61000-3-3:1995

Safety: EN60950:2000

ETS: TBR 21:1998
EG 201121 V 1.1.3/02.00

Council Directives:
73/23/EEC
89/336/EEC
92/31/EEC
93/68/EEC
1999/5/EC

CASIO Europe GmbH
Bornbarch 10, D-22848 Norderstedt, Germany

The CE marking indicates compliance to applicable European Directives and Norms declared by;

 MPC701M50E#p152~156 02.11.22, 10:18 AM152



153

3

GUIDELINES LAID DOWN BY FCC RULES FOR USE OF THIS UNIT IN THE U.S.A.
(not applicable to other areas.)

NOTICE
This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the
following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
FCC WARNING
Changes or modifications not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

Declaration of Conformity
Model Number: MPC-701M50E, MPC-701M30E
Trade Name: CASIO
Responsible party: CASIO INC.
Address: 570 Mt. Pleasant Avenue, Dover, New Jersey 07801.
Telephone number: 973.361.5400

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1)This device may not cause harmful interference, and
(2)this device must accept any interference received, including interference that
may cause undesired operation.

Industry Canada
“This digital apparatus does not exceed the Class B limits for radio noise
emissions from digital apparatus as set out in the interference-causing
equipment standard entitled “Digital Apparatus”, ICES-003 of the
Department of Communications.”

Industrie Canada
“Cet appareil numérique respecte les limites de bruits radioélectriques
applicables aux appareils numeriques de Classe B prescrites dans la
norme sur le matériel brouilleur : “Appareils Numériques”, NMB-003
édictée par le ministre des Communications.”
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Specifications

*1 Though TFT screens are made using extremely high-grade technology, uneven brightness or fine dots
sometimes occurs on these screens. Also, some dots on the screen do not light or stay continually lit. These,
however, are not malfunctions.

*2 • Operating time and charging time using the battery pack sometimes differ from the above values
depending on the operating environment and the options that are connected.

• The battery operating time was measured using JEITA-compliant battery operating time measurement
methods under the following conditions:

JEITA: Japan Electoronics and Information Technology Industries Association
JEITA is a new industry organization in Japan with activities covering both the electronics and information
technology(IT) fields.

Product Name MPC-701M30E MPC-701M50E

CPU
Type Transmeta CrusoeTM TM5800
Clock speed 800 MHz

Cache 128 KB (primary), 512 KB (secondary)

Memory
Standard (On Board) 128 MB
Max. (expansion slot ×1) 384 MB

Built-in hard disk Ultra DMA66 20 GB

Display
functions*1

Display unit 8.4" VE-transflective TFT LCD 8.4" Transmissive TFT LCD
Resolution 800 × 600 (SVGA)

Input devices
Keyboard 0 to 9 keys, arrow cursor keys, control keys
Touch panel Analog resistive film type touch panel

Standard external
interfaces

Infra-red 1 channel
PC card Type II × 1 slot (Card Bus compatible)
CF card Type II × 1 slot
RGB 1 channel
USB 2 channels (left: USB Ver.2.0, right: USB Ver.1.1)
LAN 1 channel (100Base-TX/10 Base-T compatible)
Modem Baud rate: 56 kbps max. (V.90Kflex, FAX: 14.4 kbps)

Sound functions Speaker (built-in monaural), headphone (stereo mini jack),
microphone (monaural mini jack)

Power management Automatic or any setting possible
Clock function Clock battery backup
Drip-proof function JIS drip-proof Class II compliant

Battery pack*2 

Specifications Lithium ion battery (nominal: 11.1 V, 2000 mAh)

Operating time (For one battery pack) M30E: 5 hrs approx. (CASIO standard), 3.5 hrs approx. (JEITA measurement method)
M50E: 4 hrs approx. (CASIO standard), 3 hrs approx. (JEITA measurement method)

Charging time (For one battery pack) With power ON: 2.5 hrs approx., With power OFF: 2.5 hrs approx.
External dimensions (mm) Approx. 247 (W) × 222 (D) × 26 (H)
Weight (g) Approx. 1,400 g (with two battery packs installed)
Max. power consumption 45 W, AC adapter 16 V (100-240 VAC, 50/60 Hz input)

Ambient operating temperature 0 to 40°C (no condensation)

Product Name MPC-701M30E MPC-701M50E
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Display unit Resolution 800 × 600 High Color (16 bits)

Power setting (control panel) Mobile Cockpit # in use
Other power management setting Battery alarm setting (battery power drop, warning) is invalid.
CPU clock speed Fixed at 366 MHz (set in Mobile Cockpit #)

Volume
(measurement method a): Minimum, 
(measurement method b): Regular (not specified)

Brightness Set back light OFF 
(m.m.a): 2/8, (m.m.b): 1/8 
(set in Mobile Cockpit3)

Playback software/playback screen display size (measurement method a): Windows Media Player/display size
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Options List

The useful options shown below are available for use with the FIVA MPC-701 Series.

Expansion memory board Floppy disk drive
(part No.: MPC-252RAM)   64 MB (part No.: MPC-240FDD)
(part No.: MPC-253RAM) 128 MB
(part No.: MPC-754RAM) 256 MB

AC adapter Battery holder
(part No.: AD-S60160A-E) (part No.: MPC-720CS)

Stand Screen protector
(part No.: MPC-710ST) (part No.: MPC-730PS5)

CD-ROM drive Car adapter
(part No.: MPC-142CDD2) (part No.: MPC-780CAR-E)

Battery pack Dual battery charger
(part No.: MPC-773BAT) (part No.: MPC-770CHG)
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FIVA User’s Guide
(Product No:MPC-701 series)

1st. ed. 2002-11

CASIO COMPUTER CO., LTD.
6-2, Hon-machi 1-chome

Shibuya-ku, Tokyo 151-8543, Japan

Notes
• This guide cannot be reproduced or duplicated in any form, in part or in whole, without

written permission from CASIO COMPUTER CO., LTD.
• The content of this guide is subject to change without notice.
• CASIO has, to the best of its ability, endeavored to make this guide as accurate as possi-

ble. However, if any unclear portions or omissions are found, please contact your dealer.

Descriptions and specifications furnished herein the User’s Guide by CASIO Computer Co.,
Ltd. are believed to be accurate and reliable. However, CASIO reserves the right to make
changes or improvements in the descriptions and specifications without any advanced notice.
CASIO does not assume any liability arising from the use of the contents, nor for any
infringements of patents or other rights of third parties which may result from the use of the
contents.

© 2002 CASIO COMPUTER CO., LTD. All rights reserved.

MPF0102698-01
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